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Предисловие 

В начале 1970-х годов в Университете Калифорнии (Беркли) создана программа  
SPICE 2 – Simulation Program with Integrated Circuit Emphasis. В январе 1984 года 
компания MicroSim выпустила программу PSpice (Personal), предназначенную для ПК. 
Компания MicroSim была приобретена фирмой OrCAD, затем Cadence Design Systems. В 
настоящее время усовершенствованная программа PSpice интегрирована в САПР OrCAD 
и Cadence Allegro. Принципы и приемы SPICE-моделирования используются и во многих 
др. программных пакетах. 

Настоящий лабораторный практикум ориентирован на программный 
пакет PSpice Student v. 9.1 (распространяется свободно). В составе пакета 
четыре основных программных модуля: OrCAD Capture – графический 
редактор схем; PSpice Schematics – графический редактор схем, 
заимствованный из пакета MicroSim DesignLab; OrCAD PSpice A/D – 
программа моделирования аналоговых и смешанных аналогово-цифровых 
устройств, данные в которую передаются как из PSpice Schematics, так и из 
OrCAD Capture; OrCAD Optimizer – программа параметрической 
оптимизации. 

Целью лабораторного практикума является приобретение студентами 
навыков работы в OrCAD PSpice с графическим редактором PSpice 
Schematics.  

Основные темы лабораторных работ: 1) моделирование статических 
режимов, 2) анализ в частотной области, 3) анализ переходных процессов, 4) 
биполярный транзистор, 5) ключ на биполярном транзисторе, 6) 
усилительный каскад на биполярном транзисторе, 7) влияния разброса 
параметров элементов на характеристики схемы, 8) параметрическая 
оптимизация.  

Отчеты по лабораторным работам должны содержать: введение с 
указанием цели работы, описание объекта исследования, результаты расчетов 
и виртуальных экспериментов в виде графиков, таблиц,  временных диаграмм 
и т. п., выводы.  
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1 АНАЛИЗ ПО ПОСТОЯННОМУ ТОКУ 

1.1 Цель работы  
Ознакомление с графическим редактором PSpice Schematics, 

приобретение навыков анализа аналоговых схем по постоянному току. 

1.2 Задание 
1.2.1 Ознакомиться с описанием работы и ответить на контрольные 

вопросы. Получить у преподавателя схему для анализа. 
1.2.2 Сформировать эквивалентную схему модели. Аналитически 

рассчитать узловые напряжения и токи ветвей, малосигнальную 
передаточную функцию в режиме по постоянному току, входное и выходное 
сопротивления цепи. 

1.2.3 С помощью OrCAD PSpice рассчитать узловые напряжения и токи 
элементов в статическом режиме, малосигнальную передаточную функцию, 
входное и выходное сопротивления цепи. 

1.2.4 Проанализировать результаты и оформить отчет. 

1.3 Графический редактор PSpice Schematics 
Обеспечивает редактирование схемы и условных графических 

обозначений (УГО) компонентов. После первоначальной загрузки основного 
исполняемого файла  psched.exe устанавливается режим редактирования 
схемы. При необходимости с помощью меню File > Edit Library  можно 
перевести редактор в режим редактирования УГО. 

В левом верхнем углу окна PSpice Schematics размещается имя файла 
текущей схемы и номер листа. Звездочка (*) перед именем схемы означает, 
что в схему внесены изменения, которые еще не сохранены. После номера 
страницы в скобках указывается состояние схемы: simulation – выполнение 
моделирования; simulation error  – ошибки, возникшие при моделировании, 
current  – отсутствие изменений в схеме после выполнения моделирования, 
stale – измененная схема. 

Через меню Options > PageSize вызывается окно выбора формата рабочего поля. 
Формат можно изменять на любом этапе работы со схемой. С помощью поля Title Block 
Symbol окна Editor Configuration (вызов через меню Options > Editor Configuration) 
можно назначить вывод углового штампа на каждый лист схемы. Кнопка Page Settings 
(Установки страницы) вызывает окно, в поле Drawing Area (Область рисования) 
которого задают размеры области доступной для рисования схемы. Если в поле Borders 
(Границы) выбрана опция Outline, границы области рисования отображаются в виде 
прямоугольника без маркировки областей.  

Добавление в проект нового листа осуществляется с помощью меню Navigate > 
Create Page, каждому новому листу с помощью поля Page Title окна Create Page можно 
задать имя, характеризующее схему (часть общей схемы) на данном листе. Выбор 
текущего листа (переключение между листами схемы) осуществляется с помощью меню 
Navigate > Select Page. 
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Схема создается из УГО компонентов. Для поиска модели компонента в 
библиотеках через пункт меню Draw > GetNewPart (Ctrl+G) (или с помощью 
кнопки  на панели инструментов) открывается окно Part Browser Advanced. 
Имя модели (или его часть) можно набрать в поле PartName. Если искомый 
компонент имеется в составе библиотек, то в поле Library  (Библиотека) с 
указанием пути размещения на компьютере будет выведено название файла 
библиотеки, где находится компонент, в поле чуть ниже, будет представлено 
его УГО, в поле Full list  (Полный список) данный компонент будет подсвечен 
курсором. В поле Description (Описание) будет приведено краткое описание 
подсвеченного компонента. 

Можно воспользоваться также поиском по описанию с помощью поля Description 
Search (Поиск по описанию). Введя в указанном поле Amplifier (Усилитель) и нажав затем 
кнопку Search (Поиск), получим список всех операционных усилителей, имеющихся в 
библиотеках пакета Orcad. При этом поле Full list  меняет свое название на Partial List 
(Часть списка). Для того, чтобы снова вернуться к полному списку компонентов в 
библиотеках, в поле Description Search необходимо ввести * и нажать кнопку Search. 

С помощью кнопки Libraries (Библиотеки), вызывается окно Library Browser. Оно 
позволяет посмотреть состав той или иной библиотеки. Названия файлов библиотек 
Orcad указывают либо на производителя электронных компонентов, модели которых 
содержатся в библиотеке (anlg_dev.slb – компоненты фирмы Analog Device, siemens.slb – 
компоненты фирмы Сименс), либо на тип элементов (opamp.slb – операционные 
усилители, opto.slb – оптопары, source.slb – модели источников различных сигналов). 

Выбор компонента, размещаемого на схеме в рабочем поле, 
заканчивается нажатием на кнопку Place (Разместить) или Place&Close 
(Разместить и закрыть), в последнем случае окно выбора компонентов 
закрывается.  

С помощью мыши выбирается место положения УГО компонента на 
схеме и кликом левой кнопки мыши оно фиксируется. Если УГО требуется 
повернуть, то до его фиксации это можно сделать с помощью нажатия 
клавиш Ctrl+R (Rotate – Повернуть), а после фиксации, требуется 
предварительно выделить УГО с помощью клика левой кнопкой мыши по 
нему, при этом УГО изменяет цвет. Далее можно применить указанное выше 
сочетание клавиш или Ctrl+F (Flip  – Отобразить зеркально) для зеркального 
отражения УГО. 

Соединения выводов УГО электрическими связями выполняется с 
помощью команды меню Draw > Wire (Рисовать > Проводник) (Ctrl+W). При 
активизации этой команды вид указателя мыши меняется со стрелки на 
карандаш. Начало цепи, точка излома, точка соединения с другой цепью или 
выводом компонента фиксируется щелчком левой кнопки мыши. 

Если в поле окна Display Options, вызываемого через меню Options > DisplayOptions 
(Опции > Опции дисплея) включена опция Orthogonal (Ортогонально), то цепи на схеме 
проводятся только по горизонтали или вертикали. Для прокладки цепей под произвольным 
углом следует данную опцию отключить. 

Щелчок правой кнопкой прекращает рисование цепи. Двойной щелчок 
правой кнопкой мыши в любом месте рабочего поля вызывает последнюю 
используемую команду. 
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Каждая новая цепь (узел) на схеме нумеруется автоматически (по 
умолчанию). Именование цепей осуществляется по команде Edit > Label 
(Ctrl+E) (Редактировать > Метку). Данная команда активна лишь в том 
случае, если выбран какой-либо участок цепи на схеме. Выбор 
осуществляется единичным кликом левой кнопкой мыши на участке цепи. 
Двойной, быстрый клик приведет к автоматическому выполнению команды 
Edit > Label, что наиболее удобно при работе. 

Электрические соединения пересекающихся проводников обозначаются 
жирной точкой. Если провести два проводника, не останавливаясь в точке их 
пересечения, то электрическое соединение не образуется. Точка соединения 
автоматически проставляется только для Т-образных пересечений проводников. При 
включенной опции Rubberband (Резиновая лента) окна Display Options, уже проложенная 
цепь в процессе редактирования растягивается как резиновая нить, при выключенном 
параметре, участок цепи перемещается в рабочем поле без изменения своих размеров. 

Определение значений параметров для любых компонентов 
производится в окне настройки компонента, появляющемся после двойного, 
быстрого клика левой кнопкой мыши на УГО компонента.  

Параметры компонента, отмеченные * невозможно редактировать с 
помощью данного окна, все же остальные открыты для редактирования. 
Примером не редактируемого параметра является позиционное обозначение 
любого компонента на схеме – REFDES. Данный параметр компонента 
можно скорректировать индивидуально, в окне Edit Reference Designator 
(Редактирование позиционного обозначения), выполнив аналогичный 
двойной клик непосредственно на нем. 

Некоторые параметры, отмеченные *, недоступны для изменения даже в 
индивидуальном порядке. 

Для большей наглядности и удобства работы со схемой тот или иной параметр 
может быть отображен рядом с УГО компонента. По умолчанию отображается 
позиционное обозначение, номинал или тип компонента. Выбрав левой кнопкой мыши 
какой-либо параметр в окне настройки компонента, и нажав кнопку Change Display 
(Изменить видимость), можно исключить или добавить выбранный параметр к 
отображаемым на схеме. Редактирование отображаемого параметра становится 
возможно отдельно от окна настройки компонента, посредством двойного клика мышью 
на его текущем значении. 

С помощью команды Options > Display Preferences можно одновременно для всех 
компонентов управлять видимостью на схеме некоторых параметров. При этом 
параметр будет виден, только если в индивидуальной настройке компонента разрешена 
его видимость и невиден в независимости от индивидуальной настройки.  

После того, как схема в редакторе выполнена, и параметры компонентов 
настроены, требуется определить, анализ каких процессов в схеме будет 
проводиться и настроить точность и параметры программы PSpice. 

PSpice позволяет проводить следующие виды анализа: 
– расчет режима цепи по постоянному току (Bias Point Delay); 
– многовариантный расчет режима по постоянному току (DC Sweep); 
– расчет малосигнальных чувствительностей в режиме по постоянному 

току (Sensitivity); 
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– расчет малосигнальных передаточных функций в режиме по 
постоянному току (Transfer Function); 

– расчет частотных характеристик (AC Sweep); 
– расчет переходных процессов (Transient); 
– спектральный анализ (Fourier Analysis); 
– многовариантный анализ при вариации различных параметров 

(Parametric); 
– статистический анализ по методу Монте-Карло (Monte-Carlo); 
– расчет чувствительности и наихудшего случая (Worst-Case). 
Выбор всех указанных видов анализа осуществляется с помощью меню 

Analysis > Setup. При выполнении этой команды появляется окно Analysis  
Setup. Определенный вид анализа активизируется после установки 
соответствующего флажка в поле Enabled (Включен) напротив кнопки с 
названием вида анализа.  

Доступ к опциям программы PSpice осуществляется нажатием на кнопку 
Options (Опции) в окне Analysis  Setup.  

Допустимая абсолютная ошибка расчета напряжений определяется 
опцией VNTOL (1мкВ), токов – ABSTOL (1пА), заряда – CHGTOL (0.01пКл). 
Допустимая относительная ошибка расчета токов и напряжений в переходных 
процессах определяется опцией RELTOL (0.001). В скобках приведены 
значения данных опций по умолчанию. 

При невозможности решения задачи с заданной точностью появляется 
окно PSpice Runtime Settings. С его помощью опции точности можно 
скорректировать прямо по ходу решения задачи и продолжить расчет (кнопка 
OK & Resume Simulation) уже с измененными ее значениями. 

Для определения количества значащих цифр в таблицах выходных 
данных имеется опция NUMDGT (4). С помощью опции WIDTH (80) можно 
регулировать длину строки выходного файла (имя_файла_схемы.out). 

Сброс всех опций на значения по умолчанию осуществляется кнопкой 
Reset All (Сбросить все).  

1.4 Анализ Bias Point 
В OrCAD PSpice анализ схем по постоянному току в рабочей точке 

выполняет команда Bias Point (точка смещения). Анализ обычно являются 
промежуточными для дальнейшего анализа схемы и специальной директивы 
не требует. Результат анализа – напряжения узлов схемы и токи элементов. 
Узловые напряжения определяются относительно опорного узла (земля), 
местоположение которого задается пользователем.  

Директива .TF в режиме анализа по постоянному току задает расчет 
малосигнальной передаточной функции (Transfer Function), входного и 
выходного сопротивления цепи. 

1.4.1 Загрузить графический редактор PSpice Schematics и ввести схему в 
ЭВМ. 
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1.4.2 С помощью меню Analysis > Setup открыть окно настройки 
моделирования и выбрать тип анализа Bias Point (рис. 1.2). 

 
Рисунок 1.2 – Выбор типа анализа 

1.4.3 Запустить симуляцию, – через меню Analysis > Simulate  (или F11 
на клавиатуре). Удостовериться в том, что симуляция завершена, и свернуть 
окно программы OrCAD PSpice A/D. 

1.4.4 С помощью меню Analysis > Examine Netlist открыть файл 
соединений Schematics Netlist. Сохранить содержимое файла в заготовку 
отчета. 

1.4.5 Отобразить на схеме результаты анализа по постоянному току – 
узловые потенциалы и токи компонентов. Управление отображением – через 
меню Analysis > Examine Netlist и с помощью пиктограмм панели 
инструментов (рис. 1.3). 

 
Рисунок 1.3– Управление отображением результатов анализа 



11 

 

1.4.6 Передвинуть с помощью мыши отобразившиеся значения токов и 
напряжений так, что бы схема имела читаемый вид (рис. 1.4). С помощью 
скриншота (Screenshot) сохранить схему в заготовке отчета. 

Для удаления избыточных  данных с экрана отметить их с помощью мыши и 
нажать кнопку с соответствующей пиктограммой. Вернуть данные на экран можно, 
отметив нужный сегмент проводника или компонент и затем щелкнув по кнопке с 
пиктограммой V или I . 

 
Рисунок 1.4 – Отображение токов и напряжений 

1.5 Малосигнальная передаточная функция 
1.5.1 С помощью меню Analysis > Setup открыть окно Transfer Function 

(рис. 1.5). В поле Input source ввести имя входного источника. В поле Output 
variable ввести обозначение выходного параметра.  

 
Рисунок 1.5 – Настройка параметров анализа для расчета 

малосигнальной передаточной функции в режиме по постоянному току 

1.5.2 Запустить симуляцию. 
1.5.3 Открыть файл с расширение *.cir, имя файла совпадает с именем 

файла схемы (*.sch). Файл *.cir создается после запуска симуляции, при условии, что в 
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схеме не было допущено формальных ошибок. Он содержит директивы моделирования, 
ссылки на файл списка соединений и др. файлы с информацией о проекте. 
Непосредственно перед моделированием программа PSpice A/D прочитывает все файлы, 
указанные в файле *.cir. На этом этапе могут быть выявлены формальные ошибки в 
задании директив моделирования, в описаниях моделей и т. п. 

Ниже приведен пример такого файла. 

* D:\Projects\S2.sch 
* Schematics Version 9.1 - Web Update 1 
* Fri Mar 01 19:44:32 2013 
** Analysis setup ** 
.TEMP 27 
.TF V(C_C1) V_V1 
.OP  
.STMLIB "S2.stl" 
* From [PSPICE NETLIST] section of pspiceev.ini: 
.lib "nom.lib" 
.INC "S2.net" 
.INC "S2.als" 
.probe 
.END 

В первой строке – имя и расположение файла с настройками моделирования. Символ 
«*» в начале строки – признак комментария. Строки, начинающиеся с «.» содержат 
директивы моделирования. 

.lib (library) подключает библиотеку моделей. Библиотека nom.lib содержит 
директивы подключения всех используемых стандартных библиотек. 

.TF задает расчет малосигнальной передаточной функции (Transfer Function) в 
режиме анализа по постоянному току, входного и выходного сопротивления. 

.probe подключает графический постпроцессор Probe, в котором строятся и 
анализируются графики (в анализе Bias Point Probe не используется). 

.INC (include) включает во входной файл любой другой файл. 

.END – конец схемного файла. 
Все связанные файлы проекта – это текстовые файлы, которые могут быть 

включены не только как ссылки, но и как текст. Можно вносить изменения в схему, 
формировать задания на моделирование, подключать библиотеки и т. п. пользуясь любым 
текстовым редактором.  

1.5.4 Сохранить текст из схемного файла в заготовке отчета, удалив из 
него пустые строки.  

1.5.5 Открыть выходной файл (имеет расширение *.out).  
В PSpice A/D – через меню View > Output File (или щелкнуть 

соответствующий значок панели инструментов), в программе PSpice 
Schematics – Analysis > Examine Output. 

Часть результатов моделирования, а также сообщения об ошибках моделирования 
доступны только в текстовом виде в выходном файле, в частности результаты 
расчетов по директиве .TF. 

1.5.6 Сохранить текст выходного файла в заготовке отчета, удалив из 
него пустые строки.  
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Ниже приведен фрагмент выходного файла с результатами расчета 
малосигнальной передаточной функции в режиме анализа по постоянному 
току, входного и выходного сопротивлений. 

 … 

 ****     SMALL-SIGNAL CHARACTERISTICS 
      V(C_C1)/V_V1 =  1.000E+00 
      INPUT RESISTANCE AT V_V1 =  3.000E+03 
      OUTPUT RESISTANCE AT V(C_C1) =  2.000E+03 
… 

1.6 Контрольные вопросы 
1.6.1 Какова цель работы? 
1.6.2 Каковы основные задачи анализа по постоянному току? 
1.6.3 Как изменить режим работы графического редактора PSpice 

Schematics? 
1.6.4 Какие расширения имеют файл соединений и др. файлы с 

информацией о проекте? 
1.6.5 Какие параметры задаются при настройке анализа Bias Point? 

2 АНАЛИЗ ПО ПЕРЕМЕННОМУ ТОКУ 

2.1 Цель работы  
Ознакомление с графическим постпроцессором Probe, приобретение 

навыков анализа аналоговых схем по переменному току. 

2.2 Задание 
2.2.1 Ознакомиться с описанием работы и ответить на контрольные 

вопросы. Получить у преподавателя схему для анализа. 
2.2.2 С помощью OrCAD PSpice рассчитать амплитудно-частотные и 

фазово-частотные характеристики, групповое время запаздывания, 
амплитудно-фазовые частотные характеристики. 

Источник входного воздействия, тип отклика и выходы согласовать с 
преподавателем. 

2.2.3 Проанализировать результаты и оформить отчет. 

2.3 Частотные характеристики 
Анализ схемы по переменному току в рабочей точке выполняет команда 

AC Sweep (АС – alternating current – переменный ток, Sweep – вариация, 
изменение). Свип-сигнал – колебание постоянной амплитуды с непрерывно 
изменяющейся частотой. Анализ производится при наличии в схеме 
источников с атрибутом AC или ACMAG , таких как источник переменного 
тока IAC или источник переменного напряжения VAC 1. Задаются 

                                                           
1 Источники гармонического сигнала могут использоваться и для анализа по постоянному току. 
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минимальное и максимальное значение частоты, общее число точек (для 
линейного шага по частоте), число точек на декаду или октаву (для 
логарифмического). 

Построение графиков и постобработка результатов моделирования 
выполняются графическим постпроцессором Probe, встроенным в PSpice A/D. 

В результате анализа AC Sweep рассчитываются комплексные узловые 
напряжения и токи ветвей. В режиме AC Sweep программа Probe 
поддерживает вычисления с комплексными числами. Ввод в строку Trace 
Expression окна Add Traces выражений для комплексных величин без 
использования каких-либо математических функций и операторов Probe, 
выводит модуль результата. Для обращения к действительной и мнимой 
части рассчитанных величин используются функции R и IMG, используется 
также функция ABS (absolute value) – абсолютное значение и аналогичная ей 
M (magnitude) – модуль.  

Амплитудно-частотная характеристика (АЧХ) – зависимость модуля 
комплексного коэффициента передачи (отношение амплитуд выходного и 
входного сигнала) от частоты. 

Фазово-частотная характеристика (ФЧХ) – зависимость разности фаз 
двух гармонических колебаний (фазовый сдвиг между выходным и входным 
сигналами) от частоты. ФЧХ можно определить и как арктангенс отношения 
мнимой и действительной части комплексного коэффициента передачи.  

Фаза частотного отклика в программе Probe находиться с помощью 
функции P(имя переменной). Функция Р (от английского phase) возвращает 
абсолютное значение фазы (сдвиг относительно 0) в градусах (degree). 
Поскольку фаза входного сигнала по умолчанию равна 0, то для нахождения 
ФЧХ можно построить фазы выходных величин, а не коэффициентов 
передачи.  

Характеристика группового времени запаздывания (ГВЗ) показывает 
время прохождения сигналов разных частот через схему, характеризует время 
задержки максимума передаваемой энергии и находится как производная от 
фазово-частотной характеристики. 

В программе Probe ГВЗ находиться с помщью функции G(имя 
переменной). Функция G (от английского group delay) вычисляет 
производную от ФЧХ в радианах по угловой частоте по формуле - dφ(ω)/dω, и 
имеет размерность времени. 

Амплитудно-фазовая частотная характеристика (АФЧХ) – зависимость 
коэффициента передачи и фазового сдвига от частоты, построенная в 
полярной системе координат – представляет собой годограф комплексного 
коэффициента передачи, называемый также диаграммой или годографом 
Найквиста. Годограф – параметрическая кривая, параметром которой 
является частота, – строится в виде кривой описываемой концом вектора 
комплексного коэффициента передачи (для АФЧХ) при изменении частоты 
от 0 до ∞, причем каждой точке кривой соответствует определенная частота.  
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При построении АФЧХ на комплексной плоскости, по оси X обычно 
откладывается вещественная, а по оси Y мнимая часть комплексного 
коэффициента передачи. В PSpice A/D, после анализа AC Sweep, 
постпроцессором Probe по умолчанию строятся графики, где по оси X 
отложена частота, а по оси Y переменная, определяемая через окно Add 
Traces или маркерами на схеме. Для построения АФЧХ требуется 
переопределить переменную по оси X, и задать переменную оси Y. 

2.4 Амплитудно-частотная характеристика 
2.4.1 Подготовить схему для анализа в частотной области. В качестве 

источника входного воздействия использовать VAC или IAC (согласовать с 
преподавателем), амплитуду переменной составляющей задать не равной 
нулю. Поскольку цепь линейная, а рассчитываются АЧХ и ФЧХ, то амплитуда входного 
воздействия роли не играет (допустимые в PSpice величины напряжений и токов – ±1010 
вольт или ампер). 

Остальные источники исключить из схемы. Источник тока имеет 
бесконечное внутреннее сопротивление (разрыв цепи), а источник напряжения нулевое 
(перемычка). 

2.4.2 Через меню Analysis > Setup открыть окно настройки 
моделирования и выбрать тип анализа AC Sweep. Первоначальные параметры 
анализа задать, как показано на рис. 2.1.  

Если выбран линейный шаг (Linear), то указывается общее число точек (Total 
Points), при логарифмическом шаге (Logarithmic) – число точек на декаду или октаву 
(Points/Decade(Octave)). Start Frequency – начальная частота анализа, не может быть 
равна 0, End Frequency – конечная частота анализа. 

 
Рисунок 2.1 – Окно настройки моделирования: настройка анализа  

AC Sweep 

2.4.3 Запустить симуляцию. 
2.4.4 Открыть выходной файл (Output File) найти и скопировать в 

заготовку отчета раздел с директивами анализа (Analysis directives). 
2.4.5 Построить графики АЧХ. 
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Открыть окно Add Traces, – в PSpice A/D команда Trace>Add Trace…, 
клавиша Insert или кнопка с пиктограммой графика на панели инструментов 
(рис. 2.2). 

 

Рисунок 2.2 – Вызов окна Add Traces 

В окне Add Traces (добавить график) с помощью клавиатуры или мыши 
ввести в строку Trace Expression выражения для АЧХ всех выходов (рис. 
2.3), как отношения выходных и входных напряжений (или токов). 

 
Рисунок 2.3 – Ввод выражений графиков в окне Add Traces 

В левой части окна Add Traces перечислены все токи и потенциалы узлов схемы. В 
правой части – список математических функций и связующих, которые программа Probe 
может применять к отдельным графикам. 
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Проанализировать вид АЧХ, открыть окно настройки моделирования 
(рис. 2.1) и изменить, если требуется, граничные частоты анализа и др. 
параметры таким образом, чтобы графики приобрели наиболее 
информативный вид. 

Если директива моделирования была изменена, запустить симуляцию 
еще раз. Запустить симуляцию можно прямо из программы PSpice A/D командой 
Simulation > Run или соответствующей кнопкой на панели инструментов.  

После каждой симуляции обнуляется информация о выражениях, введенных в 
строку Trace Expression. Избежать этого позволяет опция Show Last plot в окне Probe 
Window Display, -  открывается командой Simulation > Edit Settings…. 

2.4.6 Настроить внешний вид области построения и графиков. 
Открыть окно настройки параметров сетки и осей (Axis Settings), – 

команда Plot > Axis Settings…, либо двойной щелчок левой кнопки мыши в 
области значений одной из осей, либо выбрать пункт контекстного меню 
доступного по щелчку правой кнопки мыши по линии сетки (пункт 
Settings…). 

В разделе Scale (рис. 2.4) изменить (при необходимости) масштаб 
отображения по осям (Linear  или Log). 

 
Рисунок 2.4 – Изменения масштаба отображения по осям.  

Убрать промежуточные линии сетки, –  в окне Axis Settings на закладках 
X Grid и Y Grid в разделе Minor Grids установить флажок None (рис. 2.5). 



18 

 

 
Рисунок 2.5 – Настройка отображения промежуточных линий сетки 

Вызвать окно свойств графика (Trace Properties), – щелкнуть правой 
кнопкой мыши линию графика или значок в строке с легендами графиков, 
под осью Х. В появившемся контекстном меню выбрать пункт Properties….  

 
Рисунок 2.6 – Настройка вида графиков 

В окне Trace Properties (рис. 2.6) изменить параметры отображения 
графика: увеличить толщину линий графиков, изменить цвет и тип линий. 
Повторить действия для всех графиков. 

Аналогичным образом настраиваются параметры отображения линий 
рамки и сетки. Толщина линий влияет на качество печати и восприятия. Следует 
выбирать цвета линий, которые при черно-белой печати обеспечивают приемлемую 
четкость и контраст на белом фоне. 
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Сохранить графики АЧХ, – команда Window > Copy to Clipboard 
(сохранить в буфер обмена), в открывшемся окне в разделе Foreground 
поставить флажок change white to black (поменять белый с черным), 
щелкнуть OK . Рисунок из буфера обмена вставить в заготовку отчета (Ctrl+V 
или Shift+Ins). 

В буфер копируется область построения, включая оси, сетку, графики, подписи к 
осям, легенда и текстовые пометки. Размер изображения в буфере, зависит от 
фактического размера области построения в момент копирования.  

2.5 Фазово-частотная характеристика 
Последовательно отредактировать выражения для графиков, – дважды 

щелкнуть в строке легенды выбранное выражение и в строке Trace 
Expression открывшегося окна Modify Trace изменить формулу, например, 
V(out)/V(in) на P(V(out)). 

В окне Modify Trace в отличие от окна Add Traces разрешено только 
редактирование ранее введенного выражения. В окне Add Traces можно 
вводить несколько выражений. 

Построить графики ФЧХ и сохранить их в заготовке отчета. 

2.6 Групповое время запаздывания 
Последовательно отредактировать выражения для графиков, заменив P 

на G. Построить графики ГВЗ и сохранить их в заготовке отчета. 

2.7 Амплитудно-фазовая частотная характеристика 
2.7.1 В PSpice A/D открыть новое окно, – команда Window > New 

Window. На панели окон PSpice появится новая закладка. Переключаться 
между окнами можно щелком мыши на соответствующей закладке или с 
помощью меню Window. 

С помощью новых окон можно выводить и анализировать большое число различных 
графиков и данных, не удаляя, и не переопределяя уже существующие, т. е. работать с 
объемом информации, для которого одного окна недостаточно. 

2.7.2 Добавить в текущем окне еще несколько (по числу выходов) 
областей построения, – команда Plot > Add Plot To Window или 
соответствующий пункт контекстного меню, вызываемого щелчком правой 
кнопки мыши по области построения. 

В одном окне PSpice A/D может быть несколько систем координат, связанных с  
одной осью X, или имеющих независимые (собственные) оси. 

2.7.3 Изменить переменную, откладываемую по оси X. 
Открыть окно настройки параметров сетки и осей (Axis Settings) для 

одной из областей построения. В окне Axis Settings на закладке X Axis 
нажать на кнопку Axis Variable… (рис. 2.7). В открывшемся окне X Axis 
Variable в строке Trace Expression изменить переменную Frequency на 
вещественную часть одного из комплексных коэффициентов передачи (рис. 
2.8). 
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Рисунок 2.7 – Вызов окна X Axis Variable.  

 
Рисунок 2.8 – Изменение переменной по оси X 



21 

 

Вещественная часть комплексной переменной в программе Probe находится с 
помощью функции R(имя переменной), – от английского real – действительный, реальный. 
Функция R возвращает значение действительной части комплексной переменной в 
соответствующих единицах измерения (вольты, амперы и т. п.). 

Окно X Axis Variable аналогично Add Traces, но, как и Modify Trace, поддерживает 
ввод или изменение только одного выражения, т. е. каждая область построения может 
иметь только одну ось X. 

2.7.4 Повторить п. 2.7.3 для каждой области построения, изменяя 
переменные осей X на действительные части комплексных коэффициентов 
передачи.  

2.7.5 Добавить переменную для оси Y. 
Выбрать область построения, открыть окно Add Traces. В окне Add 

Traces в строку Trace Expression ввести выражение для мнимой части 
соответствующего комплексного коэффициента передачи. 

Мнимая часть комплексной переменной в программе Probe находится с помощью 
функции IMG(имя переменной), – от английского imaginary – мнимый. 

2.7.6 Повторить п. 2.7.5 для каждой области построения. 
В итоге должно получиться окно PSpice A/D, в котором построены 

АФЧХ, каждый график в отдельной области построения.  
Сохранить в заготовке отчета графики АФЧХ.  

2.8 Контрольные вопросы 
2.8.1 Какова цель работы? 
2.8.2 Каковы основные задачи анализа по переменному току? 
2.8.3 Какие параметры задаются при настройке анализа AC Sweep? 
2.8.4 Как построить графики АЧХ и ФЧХ? 
2.8.5 Что такое АФЧХ и ГВЗ? 

3 АНАЛИЗ ПЕРЕХОДНЫХ ПРОЦЕССОВ 

3.1 Цель работы  
Приобретение навыков анализа переходных процессов в аналоговых 

схемах. 

3.2 Задание  
3.2.1 Ознакомиться с описанием работы и ответить на контрольные 

вопросы. Получить у преподавателя схему для анализа. 
3.2.2 С помощью OrCAD получить переходные и импульсные 

характеристики схемы 
В качестве входного воздействия, использовать передний фронт 

единичного импульса напряжения или тока. Источник входного воздействия, 
тип отклика и выходы согласовать с преподавателем. 

3.2.3 Проанализировать результаты и оформить отчет. 
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3.3 Общие сведения 
Анализ переходных процессов позволяет получать характеристики 

схемы (токи, напряжения, мощности и т. д.) как функции времени. 
Выполняется по команде Transient (Time Domain), – Transient – переходной, 
Time Domain – временная область.  

Начинается анализ всегда в момент времени t = 0. В окне Transient (рис. 
3.1) указывается время окончания анализа Final Time (Конечное время). 
Результаты вычислений выводятся в виде таблиц, в выходной файл с 
расширением .out, или с возможностью представления в виде графиков, в 
выходной файл с расширением .dat, с интервалом времени, задаваемым 
параметром Print step (Шаг печати). При выводе на график применяется 
квадратичная интерполяция между дискретными отсчетами. Если требуется 
получить график не с нулевого момента времени, а позже, то можно задать 
данный момент времени в поле No-Print Delay (Задержка печати). Это бывает 
полезно для уменьшения файла данных, уменьшения времени получения 
значимых результатов или при отладке модели. 

 
Рисунок 3.1 – Настройка анализа переходных процессов 

Шаг интегрирования при расчете переходных процессов выбирается 
автоматически. Имеется возможность ограничить максимальный шаг 
интегрирования, введя значение в поле Step Ceiling (Шаг максимум). На 
минимальную величину шага интегрирования можно влиять лишь косвенно 
через параметр ITL4 , который определяет максимальное количество 
итераций при переходе к следующему моменту времени. По умолчанию 
значение параметра ITL4  равно 10 итерациям. При возникновении ошибки 
типа Convergence problem in transient analysis (Проблема сходимости в 
анализе переходного процесса) рекомендуется последовательно увеличивать 
значение параметра ITL4  c шагом 10, что в большинстве случаев может 
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помочь решить проблему сходимости. Доступ к окну, через которое можно 
отредактировать значение ITL4  осуществляется с помощью кнопки Options в 
окне Analysis Setup. 

По умолчанию, для определения начальных условий перед анализом 
переходных процессов выполняется расчет схемы по постоянному току. 
Основная информация по расчету схемы в режиме постоянного тока 
выводится в файл *.out. При установке флага Detailed Bias Pt, в файл 
выводится более детальная информация о начальных условиях – по всем 
узлам схемы в независимости от наличия в узле реактивного элемента. По 
информации в указанном файле можно понять, какие значения были взяты в 
качестве начальных условий. В случае известных начальных условий они 
непосредственно задаются на каждом реактивном элементе с помощью 
соответствующего параметра IC  (Initial condition – начальные условия). В 
этом случае расчет схемы по постоянному току для определения начальных 
условий должен быть отменен с помощью установки флага Skip initial 
transient solution (Отмена расчета начальных условий переходного 
процесса). 

При необходимости результаты частотного анализа и анализа переходного 
процесса можно представить не только как зависимости от частоты или времени, но и 
как зависимости от любых др. схемных функций. 

Импульсная характеристика – отклик схемы на дельта-функцию –
импульс бесконечно малой длительности и бесконечно большой амплитуды, с 
площадью равной единице. В моделях дельта-импульс представляют 
импульсом с конечной амплитудой, длительностью в один шаг симуляции, с 
площадью равной 1. В PSpice шаг переменный, поэтому целесообразно 
выбирать длительность импульса много меньше времени переходного 
процесса. 

Другой способ получения импульсных характеристик – 
дифференцирование переходных характеристик по времени. Сделать это 
можно с помощью средств постпроцессора Probe. Производная сигнала в 
программе Probe находится с помощью функции D(имя переменной) – от 
английского derivative – производная. 

3.4 Переходные характеристики 
3.4.1 Подготовить схему для анализа. В качестве источника входного 

воздействия взять источник VPULSE (или IPULSE), параметры источника 
приведены в табл. 4.1. 

Импульсные источники PULSE, IPULSE позволяют задавать воздействие в виде 
периодической последовательности импульсов трапецеидальной, пилообразной, 
треугольной и прямоугольной формы. При задании соответствующих параметров могут 
использоваться не только в анализе переходных процессов, но и в частотном анализе, и 
анализе по постоянному току. 

Переходная характеристика – отклик цепи на функцию включения 
(ступенчатое воздействие). PSpice оперирует конечными значениями 
переменных, и нет возможности задать идеальную функцию включения, у 
которой амплитуда нарастает мгновенно, с бесконечной скоростью. 
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Таблица 4.1. Значения параметров источника PULSE 

Параметр Значение Примечание 

V1 (I1) 0 Амплитуда подошвы импульса 
V2 (I2) 1 Амплитуда вершины импульса 
TD 0 Задержка (Time Delay) 
TR 1n Время нарастания переднего фронта (Time Rise) 
TF 1n Время спада заднего фронта (Time Fall) 
PW 2 Длительность вершины импульса (Pulse Width) 
PER 3 Период повторения (Period) 

Смоделировать функцию включения, можно подавая на вход 
прямоугольный импульс единичной амплитуды, с длительностью переднего 
фронта много меньшей длительности переходных процессов в схеме, а 
длительностью импульса больше длительности переходных процессов, т. е. 
задний фронт нужно отодвинуть в область времен установившегося режима. 

Период повторения импульсов для источников PULSE не может быть 
меньше суммы TR+PW+TF. Если длительности TR и TF задать равными 
нулю, то PSpice автоматически присвоит им значения равные 1% от общего 
времени анализа. 

3.4.2 Через меню Analysis > Setup открыть окно настройки 
моделирования и выбрать тип анализа Transient. Первоначальные параметры 
анализа в окне Transient задать, как показано на рис. 3.1.  

3.4.3 Запустить симуляцию. 
3.4.4 Открыть выходной файл (Output File) найти и скопировать в 

заготовку отчета раздел с директивами анализа (Analysis setup). 
3.4.5 Построить графики переходных характеристик. 
Открыть окно Add Traces. В окне Add Traces ввести в строку Trace 

Expression выражения для входного сигнала и откликов на всех выходах. 
Проанализировать вид полученных переходных характеристик, при 

необходимости, открыть настройки профиля моделирования (Simulation 
Settings) и изменить общее время анализа и максимальное значение шага. 
Если настройки моделирования были изменены, запустить симуляцию еще 
раз. 

Время анализа задать таким образом, что бы графики переходных 
характеристик были видны полностью, вплоть до установившегося значения. 
При изменении времени моделирования следует следить за величиной 
максимального шага. Для схемы из 5 узлов и 9 ветвей, при разнице между временем 
моделирования и шагом в 106 раз, файл результатов анализа может превысить 100 
Мбайт. 

Увеличить толщину графиков, при необходимости – цвет, тип линии. 
Сохранить графики переходных характеристик в заготовке отчета. Если 
временные отклики имеют времена переходных процессов, отличающиеся на 
несколько порядков, построить и сохранить графики отдельно, с различными 
временами моделирования. 
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3.5 Импульсные характеристики 
Построить графики импульсных характеристик. 
Удалить график входного сигнала. Для этого щелкнуть выражение для 

графика мышью и нажать клавишу Delete. 
Последовательно отредактировать в строке легенды выражения для всех 

графиков, пример: V(out) → D(V(out)). 
В полученном результате из-за большой скорости нарастания переднего 

фронта входного импульса, производная в первый момент времени велика 
(для источника напряжения – 1 ГВ/с, при длительности переднего фронта 1 нс 
и амплитуде 1 В), и на фоне этого значения менее амплитудные изменения не 
видны. Следует отмасштабировать оси таким образом, чтобы исключить из 
области построения начальный момент времени (момент включения), и стали 
заметны менее амплитудные и более информативные изменения импульсных 
характеристик. 

При необходимости можно изменить диапазон отображаемых по оси Х 
значений. Открыть окно настройки параметров сетки и осей (Axis Settings). 
На закладке X Axis в разделе Data Range поставить флажок User Defined 
(определяется пользователем) и отредактировать начальное и конечное 
значение оси X (рис. 3.2).  

 
Рисунок 3.2 – Масштабирование оси X через опции окна Axis Settings 

Масштабные суффиксы в программе Probe немного отличаются от используемых в 
PSpice. Суффикс Мега – 106, записывается как М, за суффиксом милли – 105-3, закреплено 
m. Программа PSpice не различает большие и маленькие буквы. 



26 

 

Можно также отмасштабировать и ось Y, – для оптимального отображения 
графиков импульсных характеристик. 

Сохранить графики импульсных характеристик в заготовке отчета.  

3.6 Контрольные вопросы 
3.6.1 Какова цель работы? 
3.6.2 Каковы основные задачи анализа переходных процессов? 
3.6.3 Как связаны переходная и импульсная характеристики схемы? 
3.6.4 Как в PSpice построить переходную и импульсную характеристики? 
3.6.5 Какие параметры задаются при настройке анализа Transient? 

4 БИПОЛЯРНЫЙ ТРАНЗИСТОР 

4.1 Цель работы  
Ознакомление с методиками создания библиотеки компонентов и 

построения статических характеристик нелинейных элементов на примере 
биполярных транзисторов. 

4.2 Задание  
4.2.1 Ознакомиться с описанием работы и ответить на контрольные 

вопросы. Получить у преподавателя файл spice-модели и паспортные данные 
(datasheet) биполярного транзистора (БТ). Документация и spice-модели БТ 
доступны на сайтах производителей. 

4.2.2 На основе spice-модели БТ создать файл библиотеки графических 
символов (*.slb). 

4.2.3 Построить семейство выходных и входных вольтамперных 
характеристик (ВАХ) БТ для схемы включения с общим эмиттером.  

4.2.4 Проанализировать результаты и оформить отчет. 

4.3 Режимы работы БТ и статические характеристики 
В большинстве электрических схем один из трех выводов БТ является 

общим для входной и выходной цепи. Соответственно, возможны три схемы 
включения транзисторов (рис. 4.1): схема включения с общей базой (ОБ), 
общим эмиттером (ОЭ) и общим коллектором (ОК).  

 
Рисунок 4.1 – Схемы включения n-р-n транзистора 
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При этом любой из р-n переходов БТ может быть смещен как в прямом, 
так и в обратном направлениях. В зависимости от этого различают четыре 
режима работы транзистора: нормальный активный (усиления), отсечки, 
насыщения и инверсный активный.  

Рассмотрим каждый из этих режимов на примере n-р-n БТ. Для p-n-p 
транзистора все рассуждения аналогичны, с заменой слова «электроны» на 
«дырки», и наоборот, а также с заменой всех напряжений противоположными 
по знаку. 

Приведенные на рис. 4.1 полярности напряжений (UЭБ < 0, UКБ > 0) 
обеспечивают открытое состояние эмиттерного перехода и закрытое 
состояние коллекторного перехода n-p-n транзистора, что соответствует 
нормальному активному режиму его работы. Активный режим является 
основным при использовании БТ для усиления сигналов. В этом режиме 
инжектированные из эмиттера в базу электроны диффундируют к коллектору. 
Поле коллекторного перехода втягивает электроны в область коллектора, т. е. 
происходит экстракция электронов в коллектор. Часть инжектированных из 
эмиттера электронов рекомбинирует с основными носителями заряда в базе – 
дырками. Однако, из-за того что базу делают очень тонкой и сравнительно 
слабо легированной, большая часть электронов доходит до коллектора. 
Потери носителей заряда на рекомбинацию в базе образуют ток базы  

IБ = IЭ - IК.  

Инверсный режим работы транзистора аналогичен активному режиму с 
той разницей, что в открытом состоянии находится коллекторный переход, а 
в закрытом − эмиттерный. Поскольку усилительные свойства транзистора в 
инверсном режиме много хуже, чем в активном режиме, инверсный режим 
практически не используется. 

Режимы отсечки и насыщения являются основными, когда БТ работает в 
ключевых и логических схемах. В режиме отсечки оба перехода транзистора 
находятся в закрытом состоянии, сквозные потоки электронов отсутствуют. 
Через переходы транзистора протекают потоки неосновных носителей заряда, 
создающие малые и неуправляемые тепловые токи. База и переходы 
транзистора в режиме отсечки обеднены подвижными носителями заряда, их 
сопротивление оказывается очень высоким. Поэтому часто считают, что 
транзистор в режиме отсечки представляет собой разрыв цепи.  

В режиме насыщения оба перехода транзистора находятся в открытом 
состоянии. И эмиттер, и коллектор инжектируют электроны в базу, в 
результате чего в структуре протекают два встречных сквозных потока 
электронов (нормальный и инверсный). От соотношения этих потоков 
зависит направление токов, протекающих в цепях эмиттера и коллектора. 
Область базы перенасыщена избыточными электронами, и 
рекомбинационный ток базы – значительно выше, чем в активном или 
инверсном режиме. Сопротивление базы и переходов транзистора – очень 
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малы. Поэтому транзистор в режиме насыщения можно считать 
короткозамкнутыми.  

Как четырехполюсник БТ характеризуется входным UВХ и выходным 
UВЫХ напряжениями и входным IВХ и выходным IВЫХ токами. 
Функциональные зависимости между этими величинами называются 
статическими характеристиками. Чтобы установить такие функциональные 
зависимости, необходимо две из указанных величин взять в качестве 
независимых переменных, а две оставшиеся выразить в виде функций этих 
независимых переменных. Как правило, применительно к БТ в качестве 
независимых переменных выбирают входной ток IВХ и выходное напряжение 
UВЫХ. В этом случае входное напряжение и выходной ток выражаются 
следующим образом:  

UВХ = F1(IВХ, UВЫХ),   

IВЫХ = F2(IВХ, UВЫХ). 

На практике удобнее использовать функции одной переменой. Для 
перехода к таким функциям необходимо вторую переменную, называемую в 
этом случае параметром характеристики, поддерживать постоянной. В 
результате получаются четыре типа характеристик транзистора: 1) входная 
характеристика: UВХ = f1(IВХ) при UВЫХ = const; 2) характеристика обратной 
передачи (связи) по напряжению: UВХ = f2(UВЫХ) при IВХ = const; 3) 
характеристика (прямой) передачи тока, называемая также управляющей или 
передаточной характеристикой: IВЫХ = f3(IВХ) при UВЫХ = const; 4) выходная 
характеристика: IВЫХ = f4(UВЫХ) при IВХ = const. 

Статические характеристики БТ могут задаваться аналитическими 
выражениями или графически. Несколько характеристик одного типа, 
полученные при различных значениях параметра, образуют семейство 
характеристик. Семейства входных и выходных характеристик транзистора 
считаются основными и приводятся в справочниках, с их помощью легко 
могут быть получены два других семейства характеристик.  

Входные характеристики БТ относятся к эмиттерному переходу. В 
активном режиме на эмиттерный переход подается прямое напряжение. 
Поэтому входные характеристики БТ аналогичны характеристике прямого 
тока диода. Выходные характеристики подобны характеристике обратного 
тока диода, т. к. они отражают свойства коллекторного перехода, 
работающего при обратном напряжении. Конкретный вид статических 
характеристик зависит от схемы включения транзистора. На практике 
наиболее часто используется схема включения с ОЭ.  

В схеме с ОЭ (рис. 4.1, б) входным током является ток базы IБ, а 
выходным – ток коллектора IК, входным напряжением является напряжение 
UБЭ, а выходным – напряжение UКЭ. Входная характеристика транзистора, 
включенного по схеме с ОЭ, обычно представляется в виде IБ = f(UБЭ). При 
UКЭ = 0 она подобна вольтамперной характеристике полупроводникового 
диода в прямом направлении (рис. 4.2, а – кривая UКЭ = 0). 
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Экспоненциальный рост тока базы IБ при увеличении UБЭ связан с 
увеличением инжекции электронов в базу и соответствующим усилением их 
рекомбинации с дырками. При увеличении напряжения на коллекторе UКЭ за 
счет эффекта Эрли (т. е. уменьшения эффективной ширины базы WЭФФ из-за 
расширения коллекторного перехода) уменьшается рекомбинация носителей 
в базе и ток базы. Следовательно, характеристика смещается вниз (рис. 4.2, а 
– кривая UКЭ > 0). 

 
Рисунок 4.2 – Семейство входных (а) и выходных (б) характеристик БТ в 

схеме с ОЭ 

В схеме с ОЭ выходная характеристика БТ – зависимость IК = f(UКЭ) при 
IБ = const. Напряжение UКЭ распределяется между обоими переходами, и при 
UКЭ < UБЭ напряжение на коллекторном переходе меняет знак и становится 
прямым, в результате транзистор переходит в режим насыщения при UКЭ > 0 
(рис. 4.2, б). В режиме насыщения характеристики сливаются в одну линию, 
то есть ток коллектора не зависит от тока базы. Так же, как и в схеме ОБ, 
идеализированная характеристика в активном режиме не зависит от 
напряжения UКЭ. Реально имеет место заметный рост тока IК с ростом UКЭ 
(рис. 4.2, б), связанный с эффектом Эрли. Этот рост выражен значительно 
сильнее, чем в схеме ОБ из-за более резкой зависимости от напряжения на 
коллекторном переходе коэффициента передачи тока базы βС по сравнению с 
коэффицентом передачи тока эмиттера αС. Также более резкой зависимостью 
βС от тока эмиттера и, соответственно, от тока базы объясняется практическое 
отсутствие эквидистантности характеристик.  

При IБ = 0 в цепи коллектора протекает ток IКЭ0 = βС IБЭ0. Увеличение 
тока в βС раз по сравнению со схемой ОБ объясняется тем, что в схеме ОЭ 
при IБ = 0 и UКЭ > 0 эмиттерный переход оказывается несколько приоткрыт 
напряжением UКЭ, и инжектируемые в базу электроны существенно 
увеличивают ток коллектора. 

4.4 Создание библиотеки компонентов 
4.4.1 Средствами Windows создать папку, в которой будет размещаться 

проект, и поместить в нее файл описания spice-модели БТ. 
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Spice-модель транзистора, как и любая другая spice-модель, представляет собою 
текст с определенными правилами синтаксиса. Может быть представлена либо в виде 
совокупности параметров (директива .MODEL в начале описания модели), либо в виде 
списка соединений подсхемы связанных компонентов со встроенными моделями 
(директива .SUBCKT – макромодель). 

Модель БТ определенная директивой .MODEL – набор параметров адаптивной 
модели Гуммеля-Пуна. Параметры не заданные в тексте модели, принимаются равными 
значениям по умолчанию. 

4.4.2 Загрузить редактор моделей – программный модуль OrCAD PSpice 
Model Editor. Открыть текстовый файл spice-модели транзистора и сохранить 
в папку проекта (с расширением файла .lib), – команда File>Open, затем 
File>Save As….  

4.4.3 Загрузить редактор PSpice Schematics. Для привязки описания 
модели к УГО (символу) компонента с помощью меню File > Edit Library  
перевести PSpice Schematics в режим редактирования символов компонентов.  

Для создания УГО модели компонента проще всего использовать Мастер 
создания символов, вызываемый через меню Part > Symbol Wizard. 

В окне Symbol Wizard выбрать метод создания символа From a model 
library (рис. 4.3) и перейти к следующему окну (рис. 4.4). 

 
Рисунок 4.3 – Выбор метода создания символа 

В окне рис. 4.4 помощью кнопки Browse (Обзор) найти файл с 
описанием PSpice модели компонента (файл должен иметь расширение .lib).  

 
Рисунок 4.4 – Выбор модели компонента 

После выбора модели, в следующем окне (рис. 4.5) задать название 
библиотеки, в которую будет записан создаваемый символ компонента. 
Библиотеки символов компонентов имеют расширение .slb. 
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Рисунок 4.5 – Выбор библиотеки символов компонентов 

 Если библиотеки символов с указанным названием нет, то требуется 
подтвердить создание файла новой библиотеки (рис. 4.6). 

 
Рисунок 4.6 – Подтверждение создания файла новой библиотеки 

Далее выводится диалоговое окно рис. 4.7. В поле Subcircuits without 
Symbols (модели без символов), представлены названия моделей 
компонентов и выводы для их подключения в схеме. Если в библиотеке уже 
есть связанные с символами модели компонентов, их перечень отобразится в 
поле Subcircuits with Symbols. При клике левой кнопкой мыши на любом 
названии модели (независимо от поля) становятся активными кнопки в 
правой части окна. 

Ряд последующих шагов выполняется для spice-моделей компонентов, 
определенных через директиву .SUBCKT (макромодель). 

Если spice-модель компонента определена через директиву .MODEL , 
поля Subcircuits without Symbols и Subcircuits with Symbols могут 
оставаться пустыми. В этом случае ряд последующих действий (окна Мастера 
создания символов рис. 4.8 – 4.11) выполняются автоматически, и после рис. 
4.8 с пустыми окнами сразу появляется завершающее окно рис. 4.12. 

На кнопку Existing Symbol необходимо нажать, если нужный символ 
есть в стандартных библиотеках Orcad. После его выбора (рис. 4.8) 
открывается окно рис. 4.9, с помощью которого выводы (pin) символа 
назначаются выводам модели компонента. Соответствие достигается кликами 
левой кнопки мыши, сначала на выводе в поле Subcircuit Terminal , затем на 
соответствующем имени вывода в поле Pin Names. 
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Рисунок 4.7 – Компонент без символа 

 
Рисунок 4.8 – Выбор символа компонента 
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В следующем окне (рис. 4.10) можно (при необходимости) ввести 
краткое описание компонента. Нажатие на кнопку Finish закрывает окно рис. 
4.10 и название модели перемещается в поле моделей имеющих символы 
(УГО), – рис. 4.11. Нажатие на кнопку Next или Finish в следующем окне 
(рис. 4.12) завершает процедуру создания библиотеки компонента.  

Возврат редактора PSpice Schematics в режим редактирования схемы –  
через меню File > Close. 

 
Рисунок 4.9 – Назначение выводов символа выводам модели компонента 

С помощью меню Analysis > Library and Include Files редактора PSpice 
Schematics можно проверить подключение библиотеки моделей компонентов. 
В поле Library Files  окна рис. 4.13 должна присутствовать соответствующая 
строка.  

Символ * в конце строки говорит о том, что данная библиотека будет 
подключаться в каждом сеансе программы PSpice Schematics, отсутствие * 
является признаком подключения библиотеки только в текущем сеансе 
работы.  

Если библиотека не подключена, то с помощью кнопки Browse ее 
требуется найти на компьютере, а затем нажать кнопку Add Library*  или 
Add Library  в зависимости от требуемого варианта подключения 
библиотеки.  
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Рисунок 4.10 – Краткое описание компонента 

 
Рисунок 4.11 – Компонент связан с УГО 
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Рисунок 4.12 – Завершающее окно Мастера создания символов 

 

Рисунок 4.13 – Подключение библиотеки моделей компонентов 

Проверка подключения библиотеки символов осуществляется через 
меню Options > Editor Configurations, окно рис. 4.14. Если имени 
библиотеки символов нет в поле Libraries , ее подключают с помощью окна 
рис. 4.15, вызываемом нажатием кнопки Library Settings  в окне рис. 4.14. 
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Рисунок 4.14 – Проверка библиотеки символов компонентов 

 

Рисунок 4.13 – Подключение библиотеки символов компонентов 

Наиболее простым способом редактирования символа (УГО) компонента 
является размещение его на принципиальной схеме, выделение кликом левой 
кнопкой мыши (символ меняет цвет) и выполнение команды меню Edit > 
Symbol. В результате PSpice Schematics переходит в режим редактирования 
символов, в рабочем окне помещается выбранный символ.  

Внесенные изменения должны быть сохранены, – команда Save 
(Сохранить). Возврат в режим редактирования схемы осуществляется с 
помощью меню File > Close. 
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4.4.4 Сохранить описание spice-модели и УГО БТ в заготовке отчета.  

4.5 Построение выходных статических характеристик 
4.5.1 Собрать схему измерений выходных статических характеристик БТ 

(рис. 4.14). 

 
Рисунок 4.14 – Схема измерений выходных статических  

характеристик БТ 

Сохранить схему измерений в заготовке отчета. 
4.5.2 Выбрать тип анализа DC Sweep (рис. 4.15).  
В ходе анализа DC Sweep производится серия анализов цепи по постоянному току, 

при изменении параметров источников напряжения, источников тока, глобальных 
параметров (например, номиналов компонентов), параметров моделей или температуры. 

 
Рисунок 4.15 – Выбор типа анализа и настройка основной переменной 

В качестве основной переменной выбрать напряжение источника Vc, 
начальное значение (Start Value) задать равным нулю. Конечное значение 
(End Value) задать равным максимально допустимому напряжению 
коллектор-эмиттер для данного транзистора (справочный параметр, указан в 
datasheet на транзистор в разделе Maximum Ratings, параметр – Collector-
Emitter Voltage), шаг (Increment) – 10 мВ.  
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В качестве параметра выбрать ток источника Ib , начальное значение 
(Start Value) задать равным нулю. Конечное значение (End Value) задать 
равным 3 мА, шаг (Increment) – 500 мкА (рис. 4.16). 

 
Рисунок 4.16 – Настройка параметра 

4.5.3 Запустить симуляцию. 
4.5.4 Построить графики выходных характеристик БТ.  
Открыть окно Add Traces. В строку Trace Expression ввести выражение 

IC(Q1) – ток коллектора БТ. Если ток отрицательный, изменить знак перед 
выражением. 

Отмасштабировать оси, так чтобы максимальные значения напряжения и 
тока коллектора соответствовали справочным параметрам, указанным в 
datasheet на БТ. 

4.5.5 Открыть выходной файл (Output File) найти и скопировать в 
заготовку отчета раздел с директивами анализа (Analysis directives). 

4.5.6 Построить гиперболу максимальной рассеиваемой мощности. 
Открыть окно Add Traces и в строку Trace Expression ввести выражение 
Pm/V_Vc, в качестве Pm подставить максимальную мощность рассеивания 
транзистора, указанную в datasheet на БТ. 

4.5.7 Сохранить в заготовке отчета семейство выходных характеристик с 
гиперболой мощности (рис. 4.17). Сравнить их с выходными 
характеристиками БТ, приведенными в datasheet. 

4.6 Построение входных статических характеристик 
4.6.1 Создать новый проект. 
4.6.2 Собрать схему измерений входных статических характеристик БТ 

(рис. 4.18). 
В качестве основной переменной выбрать напряжение источника Vb, 

начальное значение (Start Value) задать равным 0,5 В. Конечное значение 
(End Value) задать равным 0,8 В, шаг (Increment) – 1 мВ.  
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В качестве параметра выбрать напряжение источника Vc, начальное 
значение (Start Value) задать на 10 % меньше Umax_кэ/2. Конечное значение 
(End Value) задать на 10 % больше Umax_кэ/2, шаг (Increment) – 10 % от 
Umax_кэ/2. 

 

Рисунок 4.17 – Семейство выходных характеристик БТ  
с гиперболой мощности. Ib, мА: 1 – 0.05, 2 – 0.10, 3 – 0.15, 4 – 0.20,  

5 – 0.25, 6 –0.30; 7 – Pm / Vc, мА 

 
Рисунок 4.18 – Схема измерений входных статических  

характеристик БТ 

Сохранить схему измерений в заготовке отчета. 
4.6.3 Построить графики входных характеристик БТ. Сохранить их в 

заготовке отчета. 

4.7 Контрольные вопросы 
4.7.1 Какова цель работы? 
4.7.2 В чем отличия spice-моделей БТ, определенных через директивы 

.MODEL и .SUBCKT? 
4.7.3 Как создать библиотеку spice-моделей компонентов? 
4.7.4 Как связать spice-модели с символами компонентов? 
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4.7.5 Как проверить подключение библиотеки символов и библиотеки 
моделей компонентов? 

4.7.6 Как отредактировать символ компонента? 
4.7.7 Как построить семейство ВАХ БТ? 

5 КЛЮЧ НА БИПОЛЯРНОМ ТРАНЗИСТОРЕ 

5.1 Цель работы  
Приобретение навыков моделирования импульсных устройств на 

примере исследования ключа на биполярном транзисторе. 

5.2 Задание  
5.2.1 Ознакомиться с описанием работы и ответить на контрольные 

вопросы. Получить у преподавателя исходные данные для анализа. 
5.2.2 Построить передаточную характеристику ключа. Исследовать 

переходные процессы. 
5.2.3 Проанализировать результаты и оформить отчет. 

5.3 Общие сведения 
Электронные ключи служат для коммутации (переключения) цепей 

нагрузки под действием управляющих сигналов. Ключи устанавливают 
последовательно с коммутируемыми участками цепей (нагрузками) или 
параллельно им. В совокупности с др. элементами ключи входят в состав 
многих импульсных и цифровых устройств.  

На рис. 5.1, а приведена схема простейшего ключа на биполярном 
транзисторе (БТ); ЕК – напряжение источника питания, резисторы RБ и RК 
ограничивают токи базы и коллектора БТ. Управление ключом  
осуществляется входным напряжением UВХ.  

 
Рисунок 5.1 – Схема (а) и передаточная характеристика (б) 

транзисторного ключа 

На рис. 5.1, б показана передаточная характеристика ключа UВЫХ = 
f(UВХ). Входное напряжение UПОР (точка А) отвечает переходу БТ из режима 
отсечки в активный режим, UНАС (точка Б) – переходу из активного режима в 
режим насыщения. В активном режиме (наклонный участок передаточной 
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характеристики) БТ находится только во время переключения из одного 
статического состояния в другое. В точках А и Б коллекторный ток еще 
связан линейной зависимостью с током базы. Выключенному состоянию 
(ключ разомкнут) соответствует низкий уровень входного напряжения (UВХ < 
UПОР, UВЫХ ≈ EК), включенному (ключ замкнут) – высокий (UВХ > UНАС, UВЫХ 
≈ 0). Во включенном или выключенном состоянии ключ удерживается до тех 
пор, пока на входе сохраняется соответствующее напряжение. 

Статический режим. Для анализа работы ключа в статическом режиме 
на семейство выходных характеристик БТ наносят так называемую 
нагрузочную прямую (рис. 5.2): 

UКЭ = EК -  IК RК.  

Нагрузочная прямая пересекает координатные оси в точках EК (при IК = 
0) и EК / RК (при UКЭ = 0). С изменением базового тока IБ рабочая точка 
перемещается по этой прямой, определяя режим работы и, соответственно, 
выходное сопротивление БТ.  

В соответствии с функциями ключа БТ может находиться либо в режиме 
отсечки, либо в режиме насыщения. Для обеспечения режима отсечки 
необходимо выполнить условие UВХ < UПОР.  При этом ток базы IБ → 0, ток 
коллектора IК равен обратному току коллекторного перехода IКЭ0. Для 
маломощных кремниевых БТ IКЭ0 очень мал. Падение напряжения на 
резисторе  RК при IК = IКЭ0 весьма незначительно и напряжение на выходе 
ключа UВЫХ практически равно напряжению источника питания EК. Точнее 
выходное напряжение можно определить как сумму напряжений на 
элементах внешней цепи от коллектора к эмиттеру. Точка А на нагрузочной 
прямой (рис. 5.2) соответствует границе между режимом отсечки и активным 
режимом.  

 
Рисунок 5.2 – Семейство выходных характеристик  

n-p-n БТ в схеме с ОЭ 

В режиме насыщения на входе действует напряжение UВХ > UНАС, 
которое вызывает появление тока базы IБ > IБ_НАС. Ток базы IБ_НАС 
соответствует границе между активным режимом и режимом насыщения 
(точка Б, рис. 5.2). В режиме насыщения оба перехода БТ смещены в прямом 
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направлении. Остаточное напряжение UКЭ_НАС на коллекторе открытого БТ – 
весьма мало. Ток коллектора IК = IК_НАС = (EК - UКЭ_НАС) / RК ≈ EК / RК.  

Чтобы БТ не выходил из режима насыщения при изменении его 
параметров, неравенство IБ > IБ_НАС должно быть достаточно сильным. Для 
количественной оценки неравенства вводят параметр S – степень насыщения:  

S = IБ / IБ_НАС. 

Обычно S выбирают в диапазоне 1,5 ÷ 3. С увеличением степени 
насыщения повышается нагрузочная способность ключа, снижается влияние 
дестабилизирующих факторов (например, температуры), но ухудшается 
быстродействие. 

Переходные процессы. В электронном ключе переходные процессы 
обусловлены инерционными свойствами и самого БТ, и подключенных к 
нему внешних цепей.  

На рис. 5.3 приведены временные диаграммы переходных процессов в 
ключе на БТ. Цикл переключения принято делить на этапы: 1) задержка 
включения; 2) включение; 3) задержка выключения; 4) выключение.  

В исходном состоянии БТ находится в режиме отсечки, т. е. входное 
напряжение Е2 меньше порога отпирания UПОР. Задержкой включения 
называют интервал времени от момента переключения входного напряжения 
с Е2 на Е1 до начала нарастания коллекторного тока IК. Обусловлена задержка 
зарядкой входной емкости СВХ запертого БТ до напряжения отпирания UПОР. 
Завершению этапа задержки включения соответствует точка А на 
нагрузочной прямой (рис. 5.2). 

 
Рисунок 5.3 – Переходные процессы в ключе на БТ 

На этапе включения БТ находится в активном режиме. При этом ток 
базы можно считать практически неизменным (вплоть до переключения 
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входного напряжения с Е1 на Е2), т. к. обычно входное сопротивление RВХ 
транзистора много меньше сопротивления RБ: 

IБ = Е1 / (RБ + RВХ) ≈ Е1 / RБ. 

Ток коллектора IК экспоненциально увеличивается со временем. 
Увеличение IК обусловлено увеличением прямого напряжения на эмиттерном 
переходе (заряжается входная емкость БТ) и увеличением количества 
электронов, переходящих из эмиттера в базу и далее в коллектор. Заряд 
электронов в базе QБ возрастает. Этап включения заканчивается, когда ток 
коллектора IК достигает значения IК_НАС ≈ EК / RК. 

В конце этапа включения БТ оказывается на границе режима насыщения 
(точка Б, рис. 5.2). Входное напряжение Е1 выбирают так, чтобы обеспечить 
заданную степень насыщения S. Если S > 1, то после этапа включения 
начинается накопление избыточного заряда в базовом и коллекторном слоях 
БТ за счет инжекции электронов через открытые эмиттерный и коллекторный 
переходы. Внешние токи при этом существенно не изменяются, т. к. 
определяются внешними по отношению к БТ элементами схемы. 

Этап задержки выключения обусловлен рассасыванием избыточного 
заряда электронов в базовой области. В момент переключения входного 
сигнала с Е1 на Е2 на обоих переходах сохраняются прямые смещения, 
близкие к напряжению отпирания. Ток базы изменяет направление на 
обратное и принимает значение IБ = E2 / RБ. Ток коллектора IК и напряжение 
на коллекторе UКЭ не изменяются. Заряд в базовой области QБ уменьшается 
вследствие рекомбинации и ухода электронов во внешнюю цепь. Окончание 
этапа задержки выключения характеризуется тем, что концентрация 
избыточных носителей на границе базы с коллектором падает до нуля и на 
коллекторном переходе восстанавливается обратное напряжение UКБ < 0. БТ 
переходит в активный режим работы. 

На этапе выключения происходит дальнейшее рассасывание заряда 
электронов в базовой области. Уменьшаются ток IК и увеличивается 
напряжение UКЭ, рабочая точка БТ (рис. 5.2) перемещается из положения Б в 
положение А. Транзистор из активного режима переходит в режим отсечки 
(оба перехода заперты), токи базы IБ и коллектора IК уменьшаются до нуля, а 
напряжение UКЭ возрастает до величины EК. 

Для современных быстродействующих маломощных импульсных 
транзисторов длительности этапов переключения составляют единицы и 
десятые доли наносекунд, для мощных БТ – существенно больше. 

Повышение быстродействия. Для повышения быстродействия ключей 
на БТ используют более сложные схемы: с ускоряющим конденсатором, 
нелинейной обратной связью и др.  

Ускоряющий конденсатор C включают параллельно резистору RБ (рис. 
5.4, а). При переключении входного сигнала с Е2 на Е1 базовый ток БТ – ток 
зарядки конденсатора С (не ограничен RБ):  

IБ1 = (UВХ – UБЭ) / RИ, 
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где UБЭ – напряжение на эмиттерном переходе БТ, RИ – внутреннее 
сопротивление источника входного напряжения  (обычно RИ << RБ). Ток IБ1 

быстро заряжает входную емкость СВХ и накапливает заряд в базе 
транзистора QБ. Благодаря повышенному значению этого тока уменьшаются 
длительности задержки и включения БТ. 

По мере зарядки конденсатора С ток базы уменьшается до значения IБ2 = 
UВХ / RБ, определяемого сопротивлением RБ. Поскольку RБ выбирается из 
условия насыщения, по окончании входного импульса Е1 в базе 
накапливается сравнительно небольшой избыточный заряд.  

 
Рисунок 5.4 – Схема ключа с ускоряющим конденсатором 

После переключения входного сигнала с Е1 на Е2 конденсатор С 
разряжается через эмиттерный переход БТ, создавая большой запирающий 
ток базы  

IБ = UС / RИ, 

где UС – напряжение на конденсаторе. Этот ток ускоряет процессы 
рассасывания заряда и выключения БТ.  

Емкость С не должна быть слишком малой, иначе длительность 
всплесков тока будет меньше, чем длительность процессов переключения, 
которую они уменьшают. При этом процесс переключения будет протекать в 
основном при сравнительно малых токах базы, т. е. не будет ускоряться.  

Нельзя выбирать ускоряющий конденсатор и слишком большой емкости. 
В этом случае: 1) ток базы не уменьшится до уровня IБ2 к концу входного 
импульса Е1 и в базе накопится большой избыточный заряд; 2) конденсатор не 
зарядится до уровня входного импульса Е1 к моменту его окончания, 
процессы рассасывания и включения будут протекать медленнее.  

5.4 Передаточные характеристики 
5.4.1 Создать новый проект и в PSpice Schematics подготовить схему для 

измерения передаточных характеристик (рис. 5.5). 
5.4.2 В окне настройки моделирования выбрать тип анализа DC Sweep. В 

качестве основной переменной указать напряжение источника Vb, начальное 
значение (Start Value) задать равным нулю, конечное значение (End Value) 
задать равным максимально допустимому напряжению база-эмиттер для 
данного транзистора (Emitter-Base Voltage в разделе Maximum Ratings 
datasheet на транзистор), шаг (Increment) – 10 мВ. 
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Рисунок 5.5 – Схема измерений передаточной характеристики 

5.4.3 Объявить глобальный параметр. 
С помощью глобального параметра в процессе анализа можно изменять параметры 

пассивных компонентов. Вариация параметров назначается по директиве .STEP. На 
каждом шаге вариации параметров по очереди выполняются все виды анализа (.DC, .AC, 
.TRAN и др.). Две директивы .STEP в одном задании не допускаются. 

Через пункт меню Draw > GetNewPart (Ctrl+G) открыть окно Part 
Browser Basic и разместить в рабочем поле компонент PARAM. Двойным 
щелчком левой кнопки мыши на компоненте открыть окно рис. 5.6, задать 
имя и значение глобального параметра. 

 

Рисунок 5.6 – Объявление глобального параметра 

5.4.4 Номинал резистора R1 связать с глобальным параметром (рис. 5.7). 
Вызвать окно настройки (рис. 5.8), задать диапазон (Start Value, End Value) 
и шаг изменения (Increment) параметра.  

5.4.5 Запустить симуляцию и построить график передаточных 
характеристик ключа. 

5.4.6 Сохранить схему и результаты анализа в заготовке отчета. Пример 
оформления схемы приведен на рис. 5.5, передаточных характеристик – на 
рис. 5.9. 

5.4.7 Открыть выходной файл (Output File) найти и скопировать в 
заготовку отчета раздел с директивами анализа (Analysis directives). 
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Рисунок 5.7 – Установление связи резистора R1с глобальным параметром  

 
Рисунок 5.8 – Настройка глобального параметра 

 
Рисунок 5.9 – Передаточные характеристики  

R1, кОм: 1 – 0.5, 2 – 1.0, 3 – 1.5 



47 

 

 

5.5 Анализ переходных процессов 
5.5.1 Создать новый проект и в PSpice Schematics подготовить схему 

измерения переходных характеристик (рис. 5.10). В качестве источника 
входного воздействия взять источник VPULSE, параметры источника 
приведены в табл. 5.1. 

 
Рисунок 5.10 – Схема измерения переходных характеристик 

Таблица 5.1. Значения параметров источника PULSE 

Параметр Значение Примечание 

V1  0 Амплитуда подошвы импульса 
V2  2 Амплитуда вершины импульса 
TD 10n Задержка (Time Delay) 
TR 1n Время нарастания переднего фронта (Time Rise) 
TF 1n Время спада заднего фронта (Time Fall) 
PW 500n Длительность вершины импульса (Pulse Width) 
PER 1500n Период повторения (Period) 

5.4.2 В окне настройки моделирования (рис. 5.11) выбрать тип анализа 
Transient. 

5.4.3 Запустить симуляцию. 
5.4.4 Открыть выходной файл (Output File) найти и скопировать в 

заготовку отчета раздел с директивами анализа (Analysis setup). 
5.4.5 Построить графики переходных характеристик при номиналах R1 

из предыдущего раздела. 
Скопировать графики переходных характеристик в заготовку отчета, 

расположить их аналогично рис. 5.3. 
5.4.6 С использованием директивы .STEP исследовать влияние емкости 

ускоряющего конденсатора (С на рис. 5.4) на переходной процесс. 
Результаты представить в виде семейства переходных характеристик с 
емкостью ускоряющего конденсатора в качестве параметра. 
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Рисунок 5.11 – Схема для анализа переходных процессов 

5.6 Контрольные вопросы 
5.6.1 Какова цель работы? 
5.6.2 Какие режимы работы БТ являются основными при использовании 

его в ключевых и логических схемах? 
5.6.3 Что называют нагрузочной прямой? 
5.6.4 Что называют степенью насыщения? 
5.6.5 Чем обусловлены переходные процессы в электронном ключе? 
5.6.6 Какие этапы можно выделить в цикле переключения БТ? 
5.6.7 Как можно повысить быстродействия ключа на БТ? 
5.6.8 Что назначается по директиве .STEP? 

6 УСИЛИТЕЛЬНЫЙ КАСКАД НА БИПОЛЯРНОМ ТРАНЗИСТОРЕ 

6.1 Цель работы  
Приобретение навыков моделирования усилительных устройств на 

примере усилительного каскада на биполярном транзисторе (БТ). 

6.2 Задание  
6.2.1 Ознакомиться с описанием работы и ответить на контрольные 

вопросы. Получить у преподавателя исходные данные для анализа. 
6.2.2 С учетом предельно допустимых эксплуатационных параметров и 

режима работы БТ получить максимально возможный коэффициент усиления 
каскада с ОЭ по мощности. 

 



49 

 

6.2.3 Построить амплитудно-частотную характеристику (АЧХ) 
усилительного каскада, зависимость напряжения шумов на выходе каскада от 
частоты, зависимость отношения сигнал/шум от частоты. 

6.2.4 Исследовать спектральные плотности шума для БТ и остальных 
компонентов схемы, выявить элементы, дающие наибольший и наименьший 
вклад в суммарное напряжение шумов. 

6.2.5 Проанализировать результаты и оформить отчет. 

6.3 Динамические характеристики 
Входные и выходные динамические характеристики (ДХ) усилительного 

каскада – прямые линии в координатах Iб, Uб и Iк, Uк. Пример построения ДХ 
приведен на рис. 6.1.  

 
Рисунок 6.1 – Динамические характеристики каскада с ОЭ 

Точку пересечения нагрузочной прямой со статической характеристикой 
БТ при заданном токе базы называют рабочей точкой. Начальное положение 
рабочей точки БТ (точка покоя) определяется назначением схемы, 
амплитудой и формой входного сигнала и т. п. При симметричном входном 
сигнале, точку покоя P (рис. 6.1) выбирают примерно на середине 
нагрузочной линии. Если рабочая точка выбрана на линейных участках 
входной и выходной ВАХ БТ, то усилитель работает в режиме (классе) 
усиления А.  

6.3 Источники шума в схеме  
Различают тепловой, дробовой и фликкер-шум. Тепловой шум 

проводящего элемента связан с тепловым, хаотическим движением носителей 
тока, его мощность Pш определяется температурой T и диапазоном частот ∆f: 

Pш= 4kT∆f, 

где k – постоянная Больцмана. Амплитуда напряжения (тока) шума в данный 
конкретный момент непредсказуема, но подчиняется закону распределения 
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Гаусса. Шум характеризуют так же спектральными плотностями f/US 2

T

U

T ∆= , 

f/IS 2

T

I

T ∆= или рш=Рш/∆f (единицы измерения – В2/Гц, А
2/Гц или Вт/Гц, 

соответственно). Тепловой шум обычно является тем пределом, ниже 
которого нельзя ослабить шумы в электронном приборе.  

Дробовой шум вызван дискретной природой носителей заряда. 
Специфическая особенность дробового шума – физическое разделение двух 
областей: области, где случайно рождаются носители тока (катод, эмиттер 
или база), и области, где они взаимодействуют с внешним электрическим 
полем. Определяется дробовой шум током I и значением элементарного 
заряда q (подобно шуму дождя, уровень которого определяется частотой 
падения и массой капель): 

qI2SI

ä = . 

Тепловой и дробовой шумы можно представить как последовательность 
случайных импульсов, похожих по форме и случайно распределенных во 
времени. Для них характерна равномерная спектральная плотность (белый 
шум).  

Спектральная плотность фликкер-шума пропорциональна 1/f. Причины 
фликкер-шума различны. В полупроводниковых приборах он может быть 
обусловлен движением ионов, захватом носителей заряда дислокациями и др. 
причинами. Полной ясности в этом вопросе нет, хотя в некоторых условиях 
модели были получены. 

Усилительный каскад к внешнему усиливаемому шуму добавляет 
собственные шумы. Соответственно, отношения мощностей полезного 
сигнала и шума на выходе усилителя оказывается меньше, чем на входе. 
Снижение уровня шумов усилителя возможно за счет: целенаправленного 
варьирования технологических параметров транзистора (снижение 
оптимального коэффициента шума); оптимизации питания по постоянному 
току; оптимального сопряжения транзистора с внешними элементами и 
способа его подключения по отношению к входу; оптимального сопряжения 
каскадов усилителя.  

Анализ шумов в программе PSpice является составной частью частотного 
анализа (AC Sweep). Обозначения типов шумов аналоговых элементов в 
PSpice приведены в  табл. 6.1. 

Таблица 6.1. Обозначения типов шумов  
аналоговых элементов в PSpice 

Обозначение шума Тип шума 

NFIB(device_name) Фликкер-шум компонента 

NRB, NRC, NRE Тепловой шум объемных сопротивлений базы, 
коллектора и эмиттера БТ 

NSIB, NSIC Дробовой шум тока базы и коллектора 
NTOT(device_name) Суммарный шум компонента 
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Для усилителя наиболее удобной характеристикой шума является 
отношение напряжения сигнала к напряжению шума, выраженное в 
децибелах. Например, если напряжение полезного сигнала – 1В, а 
напряжение шума – 1 мВ, отношение сигнал/шум будет составлять 1000:1, 
или 60 дБ. 

6.4 Определение рабочей точки 
6.4.1 В OrCAD PSpice A/D открыть файл с выходными ВАХ и 

гиперболой мощности БТ (см. п. 4.5.7). 
6.4.2 От точки V_Vc = 0.8 Uк_max на оси Х, по касательной к гиперболе 

мощности до пресечения с осью Y провести нагрузочную прямую, – команда 
Plot > Label > Line.  

Чтобы провести линию с помощью инструмента Line, нужно мышью указать 
начальную и конечную точки линии. Для удаления линии с области построения - выделить 
линию щелчком кнопки мыши и нажать клавишу Delete. 

6.4.3 Выбрать рабочую точку на середине нагрузочной линии и с 
помощью режима трассировки зафиксировать ее параметры Iб0, Iк0, Uк0.  

Включить режим трассировки,  – команда Trace > Cursor > Display или 
щелчок соответствующего значка панели инструментов. После вызова курсора 
появляется новое окно (Probe Cursor) с текущими координатами положения двух 
курсоров обозначенных А1 и А2. В строке легенды графиков показывается, к какой именно 
диаграмме относятся операции с курсором. 

Выбрать трассируемый график и поместить на него курсор. Для выбора или 
смены трассируемого графика нужно щелкнуть мышкой по соответствующему символу 
графика в строке легенды, при этом щелчок левой кнопкой мыши закрепляет за графиком 
курсор А1, а щелчок правой – курсор А2. Переместить курсор с графика на график можно 

также с использованием сочетания клавиш Ctrl+← или Ctrl+→ (курсор А1) и 
Ctrl+Shift+← или Ctrl+Shift+← (курсор А2). 

Навести курсор на рабочую точку, и поставить метку с координатами 
(параметры рабочей точки – Iк0 и Uк0), команда Plot > Label > Mark или 
щелчок соответствующей пиктограммы панели инструментов. Зафиксировать 
в заготовке отчета значения Iк0 и Uк0. 

Метка будет поставлена курсору, который был перемещен последним. Курсор А1 
перемещается по трассируемому графику с помощью левой кнопки мыши или клавиш ← и 
→, а курсор А2 – правой, или сочетаний клавиш Shift+← и Shift+→. Для повышения 
точности можно воспользоваться масштабированием, увеличив интересующую область 
графика с помощью инструментов Zoom Area или Zoom In, вернуть график в исходный 
масштаб можно используя инструменты Zoom Fit, Zoom Out или заново 
отмасштабировав оси. После простановки метки, выключить трассировку и 
передвинуть метку мышкой на свободное пространство области построения. 

6.4.4 Сохранить в заготовке отчета рисунок семейства выходных 
характеристик с гиперболой мощности, нагрузочной линией и обозначенной 
рабочей точкой. 

6.4.5 С помощью курсоров и показаний окна Probe Cursor определить 
координаты точек пересечения линии нагрузки с осями – параметры Iк и Uк. 

Зафиксировать в заготовке отчета значения Iк и Uк. 
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6.4.6 Определить и зафиксировать в заготовке отчета параметр Iб0.  
Щелкнуть правой кнопкой мыши на выходную характеристику 

соответствующую выбранной рабочей точки, щелкнуть пункт Information . 
Аналогичную информацию можно получить двойным щелчком по значку графика в 

строке легенды. 

6.5 Амплитудно-частотные и шумовые характеристики 
6.5.1 С помощью PSpice Design Manager оздать новый проект. В PSpice 

Schematics подготовить схему усилительного каскада на БТ (рис. 6.1). 
Сопротивление R1 определить по наклону нагрузочной линии, R2 – по 

Iб0, V1 = 0.8 Uк_max БТ. 
6.5.2 В окне настройки моделирования выбрать тип анализа AC Sweep 

(рис. 6.2).  

 
Рисунок 6.1 – Схема усилительного каскада на БТ 

 
Рисунок 6.2 – Настройка анализа 

6.5.3 Запустить симуляцию. 
6.5.4 Построить АЧХ каскада по напряжению, – открыть окно Add 

Traces и в строку Trace Expressions ввести выражение V(out)/ V(in) . 
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6.5.5 Построить зависимость напряжения шумов каскада от частоты, – 
создать и выбрать вторую ось координат Y, открыть окно Add Traces и в 
строку Trace Expressions ввести выражение V(ONOISE). 

V(ONOISE), от out noise – спектральное распределение шумового напряжения в той 
точке схеме, которая при предварительной установке была указано как выход. 

Обозначение ONOISE относится к полной мощности выходного шума, 
NTOT(ONOISE) – спектральная плотность мощности выходного шума, имеет 
размерность В2/ Гц, соответственно V(ONOISE) измеряется в В/ Гц1/2. 

6.5.5 Сохранить схему и результаты анализа в заготовке отчета. Пример 
оформления схемы приведен на рис. 6.1, АЧХ и зависимости напряжения 
шумов на выходе каскада от частоты – на рис. 6.3. 

 
Рисунок 6.3 – АЧХ (1) и зависимость напряжения шумов  

на выходе каскада от частоты (2) 

6.5.6 Построить зависимость отношения сигнал/шум от частоты в 
децибелах, – открыть окно Add Traces, в строку Trace Expressions ввести 
выражение DB(V(OUT)/V(ONOISE)) . Сохранить результаты в заготовке 
отчета. 

Вычисление децибел в программе Probe происходит с помощью функции DB(имя 
переменной), DB – от английского decibel – децибел. 

6.5.7 Построить спектральные плотности шумов для источников шума в 
схеме. 

В PSpice A/D создать новое окно, команда Window > New Window. 
Открыть окно Add Traces.  В строку Trace Expressions ввести выражения 
для спектральных плотностей NFIB(Q1) NRB(Q1) NRC(Q1) NRE(Q1) 
NSIB(Q1) NSIC(Q1). 

Изменить масштаб оси Y на логарифмический. Удалить графики, 
имеющие только нулевые или близкие к нулю (порядка 10-30) значения. 
Сохранить графики шумов транзистора в заготовке отчета. 

В PSpice создать новое окно. Открыть окно Add Traces. В строку Trace 
Expressions ввести выражения для спектральных плотностей, всех резисторов 
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и суммарного шума транзистора, например, NTOT(R1) NTOT(R2) NTOT(R3) 
NTOT(R4). 

Изменить масштаб оси Y на логарифмический. Сохранить графики 
шумов резисторов в заготовке отчета. 

Емкости и индуктивности в PSpice не имеют шумовых моделей. Многие модели 
транзисторов не имеют коэффициентов для расчета фликер-шума. 

6.5.8 Открыть выходной файл (Output File) найти и скопировать в 
заготовку отчета раздел с директивами анализа (Analysis directives). 

6.6 Контрольные вопросы 
6.6.1 Какова цель работы? 
6.6.2 Какой режим работы БТ является основным в усилительных 

устройствах? 
6.6.3 Что называют динамическими характеристиками усилительных 

устройств? 
6.6.4 Что называют рабочей точкой? 
6.6.5 Как соотносятся фазы входного и выходного сигналов каскада с 

ОЭ? 
6.6.6 Какова природа шумов? 
6.6.7 Как повысить отношение сигнал/шум? 
6.6.8 Как построить спектральные плотности шумов для источников 

шума в схеме? 

7 АНАЛИЗ ЧУВСТВИТЕЛЬНОСТЕЙ 

7.1 Цель работы  
Ознакомление с методиками анализа чувствительностей, влияния 

разброса параметров элементов на характеристики схемы на примере 
усилительного каскада. 

7.2 Задание  
7.2.1 Ознакомиться с описанием работы и ответить на контрольные 

вопросы. Получить у преподавателя схему и исходные данные для анализа. 
7.2.2 Определить коэффициенты чувствительности характеристик 

каскада к разбросу параметров элементов. В качестве характеристик каскада 
использовать коэффициент передачи по напряжению и ширину полосы 
пропускания АЧХ на уровне 3дБ, в качестве параметров элементов – 
номиналы сопротивлений и емкостей, а так же коэффициент усиления тока 
базы БТ в схеме с ОЭ. Величину отклонения параметров элементов принять 
равной 10% от номинала. 

7.2.3 Проанализировать результаты и оформить отчет. 

7.3 Общие сведения 
Под чувствительностью понимают реакцию схемы на малое изменение 

ее внутренних параметров. Чувствительность позволяет:  
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1) понять, как вариация кого-либо параметра элемента влияет на отклик 
цепи;  

2) найти элементы, отклонения параметров которых от номинальных 
приводит к наибольшему отклонению выходных параметров схемы;  

3) сравнить качество различных цепей имеющих одинаковый отклик при 
номинальных параметрах;  

4) определить градиент целевой функции при оптимизации схемы и 
анализе на наихудший случай. 

Абсолютный коэффициент чувствительности (коэффициент влияния) – 
количественная оценка изменения выходного параметра yj при заданном 
изменении параметра xi: 

.dx/dyA ijji =  

В качестве выходного параметра в общем случае может использоваться 
функция качества, а в качестве xi – любой внутренний или внешний параметр. 

Коэффициент относительной чувствительности вычисляется по формуле: 
,Y/XAS jijiji =  

где Xi – номинальное значение параметра элемента; Yj – номинальное 
значение характеристики каскада. 

Наиболее простым методом оценки чувствительности является метод 
приращений, основанный на численном дифференцировании. Сначала 
рассчитывают выходных параметров в номинальном режиме. Затем 
производят расчеты коэффициентов чувствительности, в каждом из которых 
отклонение dxi от номинального значения Xi придается только одному из 
внутренних параметров xi. 

Увеличить точность можно выполняя dxi в обе стороны от номинала. В 
большинстве практических случаев точность оказывается достаточной 
при .X25,0dxX25,0 iii ≤≤−  

Наихудший случай соответствует такой ситуации, когда параметры всех 
элементов имеют максимальные по величине и такие по знаку отклонения, 
при которых возникает наибольшее отклонение выходной характеристики. 
Расчет на наихудший случай является простейшим видом определения 
разброса выходных параметров устройства без оценки плотности 
распределения этих параметров. Получаемые с помощью этого расчета 
оценки сильно завышены, что и определяет название метода. 

Величину максимальных отклонений внутренних параметров задает 
разработчик, и обычно она принимается равной допуску на номинал 
элемента, а знак отклонения определяется в ходе анализа чувствительности. 
Анализ проводится в предположении, что знаки коэффициентов 
чувствительности остаются неизменными во всей рассматриваемой области 
изменений внутренних параметров. Кроме того, как и в методе приращений, 
предполагается отсутствие сильных корреляционных связей между 
отклонениями параметров отдельных элементов. 
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В расчете на наихудший случай наибольший интерес представляют две 
ситуации: наихудший случай в меньшую (Low) и большую сторону (Hi ), т. е. 
уменьшение или увеличение выходного параметра. 

В общем случае алгоритм расчета на выбранный (Low или Hi) 
наихудший случай содержит следующие шаги: 

1) анализ чувствительности и определение знаков коэффициентов 
чувствительности; 

2) присвоение внутренним параметрам самых неблагоприятных 
значений; 

3) расчет схемы и определение выходного параметра для наихудшего 
случая. 

При большом числе корреляционных связей между внутренними 
параметрами и при нелинейных зависимостях выходных параметров от 
внутренних, расчет на наихудший случай может дать ошибочную оценку. 
Кроме того расчет на наихудший случай не позволяет оценить вероятность 
наступления этого, самого неблагоприятного, случая, которая как правило, 
низка. 

Для точной оценки влияния разброса параметров элементов на выходные 
характеристики устройства используют методы статистического 
моделирования, наиболее известным из которых является метод Монте-
Карло. 

На первом шаге алгоритма анализа Монте-Карло выполняется генерация 
случайной реализации вектора внутренних параметров устройства, при этом 
каждая компонента вектора генерируется с соответствующими 
статистическими характеристиками. На втором шаге проводится 
моделирование схемы, – определяется реализация выходных характеристик и 
вычисляются выходные параметры (коэффициент передачи, полоса 
пропускания и т. д.). Шаги 1 и 2 повторяются заданное число раз. Число 
повторений зависит от требуемой точности. При 1000 испытаний 
обеспечивается точность порядка 1 %, что вполне достаточно для практики. 
Затем по найденной совокупности реализаций выходных характеристик и 
параметров выполняется их статистическая обработка. Например, 
определяется математическое ожидание, дисперсия, их доверительные 
интервалы, границы полей допусков и т. д. По полученной совокупности 
реализаций выходных параметров строятся гистограммы распределения. 

Анализ методом Монте-Карло и расчет на наихудший случай в OrCAD 
PSpice A/D доступны как опции анализов AC Sweep, DC Sweep и Time 
Domain. Анализ чувствительности выполняется в ходе расчета на наихудший 
случай, его результаты доступны в выходном файле. Как опция, анализ 
чувствительности для статического режима доступен в анализе Bias Point. 

7.4 Порядок выполнения работы  
7.4.1 Создать новый проект и в PSpice Schematics подготовить схему 

усилительного каскада для анализа (рис. 7.1). 
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Рисунок 7.1 – Схема усилительного каскада на БТ 

Выбрать тип анализа – AC Sweep, настроить параметры для измерения 
АЧХ. Частота сигнала – из диапазона, в пределах которого АЧХ каскада по 
напряжению линейна. 

Запустить симуляцию. Построить АЧХ каскада по напряжению. Открыть 
окно Add Traces. В строку Trace Expression ввести выражения для 
коэффициентов передачи по напряжению. Сохранить график АЧХ в заготовке 
отчета. 

7.4.2 Найти коэффициент передачи каскада по напряжению в полосе 
пропускания и ширину полосы пропускания АЧХ по уровню 3дБ. 

Открыть окно Evaluate Goal Function(s) (вычисление целевых функций), 
– команда Trace > Eval Goal Function, или соответствующая пиктограмма 
панели инструментов. В строку Trace Expression ввести 
MAX(DB(V(OUT)/V(IN))) . Построить АЧХ.  

Окно Evaluate Goal Function(s) аналогично окну Add Traces, но в правой части окна 
(как и в анализе эффективности) находиться список целевых функций. 

В строку Trace Expression ввести BANDWIDTH(V(OUT)/V(IN),3) . 
Построить АЧХ. 

Зафиксировать полученные значения коэффициента передачи и ширину 
полосы пропускания в заготовке отчета (таб. 7.1, 7.2).  

Результаты расчета целевых функций можно отобразить на графике, для этого 
выполнить команду Tools > Options…, в открывшемся диалоговом окне Probe Options 
поставить флажок Display Evaluation. С данной установкой, при каждом расчете 
целевых функций будет построен график с метками и результатами вычисления, 
соответствующими введенной целевой функции. 

7.4.3 С помощью метода приращений произвести расчет коэффициента 
чувствительности характеристик каскада к разбросу параметров элементов. 

Увеличить параметр какого-либо элемента на 10%. Повторить действия 
по п. 7.4.2. Результаты внести в таблицу. 

Присвоить выбранному элементу значение параметра на 10% меньше 
номинального. Повторить действия по п. 7.4.2. Результаты внести в таблицу, 
затем вернуть параметру номинальное значение. 

Повторить действия для всех элементов схемы, кроме источников 
энергии и заполнить таблицу числовыми значениями.  
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Таблица 7.1. Относительная чувствительность коэффициента передачи 
каскада по напряжению к изменению параметров компонентов 

Компонент Номинал dxi  +К, дБ -К, дБ dК, дБ SK 

R_R1, кОм 13,5 1,35 36,191 36,208 0,017 4,053Е-03 

R_R2, Ом 26 2,6 …    
C_C1, мкФ 1 0,1 …    
C_C2, мкФ 1 0,1 …    
BF_ Q 229,798 22,98 …    
…       

Таблица 7.2. Относительная чувствительность ширины полосы пропускания 
каскада к изменению параметров компонентов 

Компонент Номинал dxi  +∆f, кГц -∆f, кГц d∆f, кГц S∆f 

R_R1, кОм 13,5 1,35 987,15666 986,16740 0,98926 0,009893 
…       

Для БТ приращения выполнять для параметра spice-модели BF – 
коэффициента усиления тока базы в схеме с ОЭ. Для изменения параметров 
spice-модели выбрать транзистор, затем команда Edit > Pspice Model или 
щелкнуть правой кнопкой и из контекстного меню выбрать Edit Ppice Model. 
В открывшемся редакторе моделей (PSpice Model Editor), найти и изменить 
параметр BF spice-модели. Сохранить изменения. 

В анализе Монте-Карло и расчете наихудшего случая в PSpice A/D учитываются 
только элементы и параметры с заданным допуском. Параметры, имеющие опцию DEV, 
получают случайный разброс значений в пределах указанной в процентах величины. 
Параметр TOLERANCE в редакторе свойств назначает DEV для пассивных компонентов 
из библиотеки ANALOG.OLB. Для пассивных компонентов из библиотеки BREAKOUT.OLB 
разброс задается редакцией spice-модели компонента, вводом и заданием DEV. 

7.4.4 Задать допуски параметров элементов. 
Вернуть всем элементам номинальные параметры. Выделить все 

сопротивления и емкости последовательными щелчками мыши, удерживая 
клавишу Ctrl, затем открыть редактор свойств компонентов, команда Edit > 
Attributes . В появившемся окне редактора свойств, ввести параметр 
TOLERANCE  для всех компонентов равный 10 %. 

7.4.5 Задать разброс для коэффициента усиления тока базы транзистора. 
Выделить транзистор, затем команда Edit > Model…. В тексте spice-модели 
транзистора, после BF=… задать отклонение DEV=25%, сохранить 
изменения. 

7.4.6 Произвести расчет на наихудший случай. Выбрать тип анализа – 
AC Sweep, настроить параметры для съема АЧХ.  
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В разделе окна Options установить флажок Monte Carlo/Worstcase, 
затем выбрать опцию Worst-case/Sensitivity. В качестве выходной 
переменной (Output variable) использовать напряжение на выходе каскада – 
V(out). Задать направление изменения выходной характеристики Hi  (рис. 7.2). 
Запустить симуляцию. 

 
Рисунок 7.2 – Настройка анализа на наихудший случай 

Построить АЧХ каскада по напряжению для всех прогонов. Открыть 
окно Add Traces. В строку Trace Expression ввести выражения для 
коэффициентов передачи по напряжению. Сохранить графики в заготовке 
отчета. 

Найти отклонения ширины полосы пропускания и коэффициента 
передачи в полосе пропускания (в децибелах) для наихудшего случая любым 
возможным способом. Можно воспользоваться трассировкой или вычислить 
соответствующие целевые функции.  

Сохранить полученные графики и числовые параметры. 
Задать направление изменения выходной характеристики Low и, 

повторив необходимые действия, вновь сохранить полученные графики и 
числовые параметры. 

В ходе расчета наихудшего случая определяются коэффициенты 
чувствительности для выходной переменной (Output variable), при этом приращения для 
параметров элементов находятся по формуле: dxi = xi ·RELTOL , где xi – номинальное 
значение параметра элемента, RELTOL – относительная точность расчета, задается 
через опции окна Simulation Settings и по умолчанию равна 0,001. Результаты анализа 
чувствительности доступны в выходном файле. 

Приращения параметров элементов для наихудшего случая принимаются равными 
заданному допуску, в нашем случае параметру TOLERANCE (DEV). 

7.4.7 Произвести анализ Монте-Карло. 
Создать новый проект.  
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Выбрать тип анализа AC Sweep, настроить параметры для расчета АЧХ.  
Установить флажок Monte Carlo/Worstcase, затем выбрать опцию 

Monte Carlo. В качестве выходной переменной использовать напряжение на 
выходе каскада – V(out), тип распределения для номиналов элементов – 
равномерное (Use distribution – Uniform), число статистических испытаний 
(«прогонов») установить не менее 200 (MC runs ≥ 200). Пример показан на 
рис. 7.3. 

Запустить симуляцию. 

 
Рисунок 7.3 – Настройка анализа Монте-Карло 

В поле Random number seed задается начальное значение генератора случайных 
чисел, оно может принимать нечетные значения в диапазоне от 1 до 32767. По 
умолчанию, начальное значение устанавливается в 17533. При одинаковых значениях 
результаты анализа Монте-Карло будут повторяться. В поле Output Variable 
указывается имя выходной переменной, подлежащей статистической обработке. В 
выпадающем меню Use distribution можно выбрать стандартный закон распределения 
случайных величин: Uniform – равновероятное распределение на отрезке (–1,+1); Gauss – 
распределение Гаусса (нормальное) на отрезке (–1,+1) с нулевым средним значением и 
среднеквадратичным отклонением СКО=0,25. Кроме того, можно задать 
нестандартный закон распределения случайных величин, щелкнув по клавише Distributions. 

Для анализа Монте-Карло случайные значения параметров компонентов 
рассчитываются по формуле: xi 6 = 0

ix ·(1+ξ·∆), где 0
ix – номинальное значение параметра 

элемента, ∆ – допуск параметра элемента, в нашем случае TOLERANCE (DEV), ξ  – 
центрированная случайная величина в диапазоне (-1,+1), формируемая генератором 
случайных чисел в соответствии с заданным законом распределения. 

Построить АЧХ каскада по напряжению для всех прогонов. Открыть 
окно Add Traces. В строку Trace Expression ввести выражение для 
коэффициента передачи по напряжению. 
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Изменить параметры отображения графиков, включив запрет показа 
символов. Команда Tools>Options…, в открывшемся диалоговом окне Probe 
Settings в разделе Use Symbols поставить флажок Never. 

Сохранить полученные графики АЧХ в заготовке отчета. 
7.4.7 Построить гистограммы статистического распределения 

коэффициента передачи и ширины полосы пропускания АЧХ. 
В PSpice A/D создать новое окно (команда View>Output File). Запустить 

анализ эффективности (команда Trace>Performance Analysis). Открыть окно 
Add Traces (команда Trace>Add Trace…). В строку Trace Expressions 
ввести выражение MAX(DB(V(OUT)/V(IN))) . 

Добавить в текущем окне еще одну систему координат (область 
построения, – команда Plot>Add Plot To Window). Открыть окно Add Traces. 
В строку Trace Expressions ввести выражение 
BANDWIDTH(V(OUT)/V(IN),3)) . 

Сохранить полученные гистограммы и числовые параметры (команда 
Window>Copy to Clipboard, затем вставить в отчет (рис. 7.4). 

Числовые параметры, полученные в результате анализа Монте-Карло: n samples – 
число прогонов, n divisions – число столбцов гистограммы; mean, maximum, minimum, 
median – среднее (математическое ожидание), максимум, минимум и медиана 
полученного распределения значений целевой функции; 10th%ile, 90th%ile – десяти и 
девяностопроцентные квантили распределения; sigma – среднеквадратическое 
отклонение. 
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Рисунок 7.4 – Гистограммы анализа Монте-Карло 

Открыть выходной файл (Output File) найти и скопировать в заготовку 
отчета раздел с директивами анализа (Analysis directives). 
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7.5 Контрольные вопросы 
7.6.1 Какова цель работы? 
7.6.2 Что такое чувствительность схемы к изменениям внутренних 

параметров? 
7.6.3 Для чего анализируют чувствительность? 
7.6.4 В чем суть метода приращений, расчета на наихудший случай, 

анализа Монте-Карло?  
7.6.5 Каковы преимущества и недостатки метода приращений, расчета на 

наихудший случай, анализа Монте-Карло? 
7.6.6 Как в PSpice рассчитываются случайные значения параметров 

компонентов для анализа Монте-Карло? 
7.6.7 Какие параметры задаются в OrCAD для проведения анализа на 

наихудший случай и методом Монте-Карло? 
7.6.8 Как в PSpice задается допуск параметра элемента? 
7.6.9 Какие директивы анализа в PSpice задают расчет на наихудший 

случай и анализ Монте-Карло? 

8 ПАРАМЕТРИЧЕСКАЯ ОПТИМИЗАЦИЯ 

8.1 Цель работы  
Ознакомление с методикой параметрической оптимизации на примере 

настройки полосового фильтра на операционном усилителе (ОУ).  

8.2 Задание  
8.2.1 Ознакомиться с описанием работы и ответить на контрольные 

вопросы.  
Получить у преподавателя исходные данные для оптимизации 

полосового фильтра на ОУ. 
8.2.2 Настроить фильтр в соответствие с исходными данными.  
8.2.3 Проанализировать результаты и оформить отчет. 

8.3 Программа PSpice Optimizer OrCAD 
В пакете OrCAD параметрическая оптимизация выполняется методом 

наискорейшего спуска путем взаимодействия модуля PSpice Optimizer с 
графическим редактором схем (PSpice Schematics или OrCAD Capture), 
программой моделирования PSpice и постпроцессором Probe. Критерий 
оптимизации – обеспечение заданного значения целевой функции при 
выполнении ряда линейных и нелинейных ограничений.  

Перечень команд программы PSpice Optimizer дан в приложении А.  
Если схема оптимизируемого устройства создается в PSpice Schematics, 

на нее наносится символ OPTPARAM из библиотеки Special.sib для 
определения списка оптимизируемых параметров. Щелчком по заголовку 
этого символа открывается панель спецификации параметров и задаются 
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следующие величины: Name – имя параметра; Initial Value  – начальное 
значение; Current Value – текущее значение (вводится либо начальное 
значение, либо текущее, либо оба); Lower Limit  – нижняя граница изменения 
параметра; Upper Limit  – верхняя граница изменения параметра;  
Tolerance – допуск стандартизованного ряда значений параметров, 
испрльзуемый при округлении значений параметров, в процентах. Нажатие 
кнопки Add Param добавляет введенные значения к списку параметров. 
После ввода последнего параметра нажимается кнопка Save Param для их 
сохранения.  

Определенные таким образом параметры должны быть использованы 
для обозначения параметров компонентов схемы и их моделей 
(сопротивлений резисторов, параметров транзисторов и т.п.).  

Далее в меню Analysis по команде Setup открывают диалоговое окна для 
задания вида анализа и диапазона изменения текущей переменной (частоты, 
времени, источника постоянного напряжения или глобального параметра).  

При создании схемы с помощью OrCAD Capture список оптимизируемых параметров 
задается по команде PSpice>Place Optimizer Parameters.  

Критерий оптимизации задается непосредственно в программе PSpice 
Optimizer, которая вызывается из меню Tools программ PSpice Schematics и 
OrCAD Capture по команде Run Optimizer для создания или редактирования 
файла задания на оптимизацию *.ОРТ.  

 
Рисунок 8.1 – Главное окно программы PSpice Optimizer  
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В правой верхней части главного окна программы PSpice Optimizer  
помещен список значений функций, которые могут быть целевыми 
функциями или ограничениями (раздел Specifications), в нижней – перечень 
варьируемых параметров (раздел Parameters).  

Значения целевых функций рассчитываются с помощью программы 
Probe. Они задаются или как целевые функции Goal Function программы 
Probe, записанные в файл с расширением имени *.PRB, или как выражения, 
заданные в программе PSpice Optimizer.  

Целевые функции программы Probe (см. приложение Б) позволяют 
рассчитать минимум или максимум функции, расстояние между 
выделенными точками, центральную частоту, полосу пропускания и т.п. 
(стандартные целевые функции размещены в файле pspice.prb).  

 а) 

б) 

Рисунок 8.2 – Окна списка (а) и редактирования (б) параметров 

В выражениях программы PSpice Optimizer разрешается использовать 
следующие математические операции и функции: +, -, *, / – арифметические 
операции; ** – возведение в степень; ЕХР(x) – ехр(х), экспонента числа х; 
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LOG(x)  – ln(x) , натуральный логарифм х; LOG10(x) – log(x), десятичный 
логарифм х; SIN(x) – sin(x), синус х (х в радианах); COS(x) – cos(x), косинус х 
(х в радианах); TAN(x)  – tg(x), тангенс х (х в радианах); ATAN(x)  – acrtg(x), 
арктангенс х (х в радианах).  

По команде Parameters меню Edit  открывается окно, показанное на рис. 
8.2, а. Нажатием кнопки Add открывается меню спецификации нового 
параметра (рис. 8.2, б). Это же окно открывается щелчком по имени 
параметра из списка рис. 8.2, а. 

 а) 

б) 

Рисунок 8.3 – Список (а) и меню спецификации (б) целевых функций и 
ограничений 
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Параметр (Parameter) – свойство схемы, для которого надлежит определить 
лучшее значение в заданных пользователем пределах. В качестве параметра можно 
использовать номинал или другое свойство элемента. 

Спецификация (Specifikation) – описание глобальной целевой функции с помощью 
локальных целевых функций (Goal Function) и ограничений. Глобальная целевая функция 
(Evaluation) – функция, значение которой является мерой соответствия реального 
режима в схеме желаемому. 

 По команде Specifikations меню Edit  открывается окно, показанное на 
рис. 8.3, а. Нажатием кнопки Add открывается меню спецификации новой 
целевой функции (рис. 8.3, б). Это же окно открывается щелчком по имени из 
списка рис. 8.3, а. 

В окне спецификации вводятся следующие данные: Name – имя 
функции;  Enabled – включение режима расчета функций на следующей 
итерации; Reference – выбор между внутренней спецификацией 
(Internal), задаваемой в диалоговом окне, и внешней (External), адресуемой к 
имени файла данных; Weight – весовой коэффициент целевой функции (с их 
помощью устанавливается важность каждой из целевых функций и 
учитывается различие их абсолютных значений). 

Внутренняя спецификация задается параметрами: Target – желаемое 
значение функции; Rang  – ширина допустимого диапазона значений 
функции; Constraint – включение/выключение режима учета ограничений. 
Если режим Constraint включен, задаваемая в этом окне функция 
является ограничением, в противоположном случае – целевой функцией;  
Тур  – тип ограничения: =target – равно, >=target – больше или равно, 
<=target – меньше или равно заданному значению функции.  

Внешняя спецификация задается параметрами: File – имя файла данных, 
содержащего значения функции; X Column Name – заголовок столбца 
данных, содержащего значения отсчетов переменной х; Y Column Name – 
заголовок столбца данных, содержащего значения отсчетов 
переменной у; Tolerance – класс допуска при округлении результатов 
вычислений до стандартных значений.  

Остальные параметры имеют следующий смысл: Analysis – выбор вида 
анализа (AC, DC или Transient); Circuit File  – имя файла схемы, к которому 
обращаются при моделировании (если оно не указано, то математические 
выражения вычисляются непосредственно); Probe File Containing Goal 
Function  – имя файла целевых функций для программы Probe (расширение 
имени по умолчанию *.PRB); Evaluate – спецификация математического 
выражения для функции. В нее могут входить имена переменных, имена Goal 
Function и имена любых параметров.  

Для разных целевых функций можно задавать разные вида анализа и 
даже разные имена схем. Например, при оптимизации фильтра можно в 
режиме АС контролировать его резонансную частоту, а в режиме Transient – 
величину выброса в переходном процессе. 

Запуск процесса оптимизации выполняется в меню Tune. По 
команде Update Performance рассчитываются характеристики схемы для 
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начальных и текущих значений каждого параметра. Это может 
использоваться для проверки корректности постановки задачи оптимизации. 
Значения целевых функций для начальных значений параметров 
отображаются в главном окне программы, что позволяет оценить близость 
этих значений к оптимальным.  

По команде Update Derivatives вычисляются чувствительности каждой 
целевой функции к изменению каждого параметра, равные частным 
производным. Информация о чувствительностях позволяет выбрать 
параметры, к изменению которых целевые функции наиболее чувствительны. 
Матрица чувствительностей отображается на экране по команде Show 
Derivatives.  

Оптимизация в автоматическом режиме запускается по команде 
Autostart. Сначала вычисляется матрица чувствительностей и определяется 
направление изменения параметров. Движение в этом направлении 
происходит до тех пор, пока не перестанет уменьшаться разность между 
текущим и требуемым значениями целевой функции. После этого снова 
вычисляется матрица чувствительностей и новое направление изменения 
параметров. По достижении оптимума процесс оптимизации завершается или 
его нужно остановить по команде Auto>Terminate. Результаты оптимизации 
отображаются в главном окне программы.  

Оптимизация в интерактивном режиме начинается с вычисления 
чувствительностей по команде Update Derivatives. После этого в основном 
окне программы изменяются значения параметров и выполняется 
команда Update Performance для расчета новых значений целевых функций. 
Однако при этом моделирование не производится, а расчет основывается на 
матрице чувствительностей. Поэтому в таком режиме изменения параметров 
должны быть небольшими. Далее снова производится расчет матрицы 
чувствительностей и вносятся новые изменения в значения параметров.  

Любой параметр или функцию можно исключить из процесса оптимизации, 
переведя выключатель около имени параметра или функции в главном меню в положение 
Disable (галочка должна исчезнуть).  

После успешного завершения оптимизации найденные значения 
параметров отображаются в главном меню. В связи с тем, что ряд параметров 
компонентов, например сопротивления резисторов, не могут принимать 
любые значения, можно выполнить округление их значений до ближайшей 
стандартной величины по команде Edit>Round Nearest Edit>Round 
Calculated. Точность округления определяется параметром Tolerance, 
который может принимать значения 1, 5 и 10%. Новые значения целевых 
функций после округления параметров рассчитываются автоматически.  

Значения найденных в процессе оптимизации параметров переносятся на 
схему по команде Edit>Update Schematic. Новые значения параметров 
отображаются в атрибутах символов OPTPARAM.  

В связи с тем что никакой регулярный метод оптимизации не может в общем 
случае обеспечить нахождение глобального экстремума, рекомендуется выполнять 
параметрическую оптимизацию в два этапа. Сначала проводят статистические 
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испытания по методу Монте-Карло, варьируя параметры в широких пределах. По 
результатам, этих испытаний определяется несколько локальных экстремумов, в 
окрестности каждого из которых выполняется оптимизация с помощью программы 
PSpice Optimizer. Другой способ – проводят несколько циклов оптимизации, интуитивно 
выбирая разные начальные значения параметров.  

По окончании оптимизации полезно просмотреть текстовые отчеты, 
составляемые по команде File>Report (расширение имени *.ООТ), и 
составляемые автоматически протоколы оптимизации (расширение имени 
*.OLG ).  

8.4 Порядок выполнения работы  
8.4.1 Создать новый проект. В PSpice Schematics подготовить схему 

полосового фильтра для AC анализа и сформировать список оптимизируемых 
параметров (рис. 8.4). 

 

Рисунок 8.4 – Схема полосового фильтра на ОУ 

Варьируемый параметр p и его начальное значение определить с 
помощью атрибутов символа OPTPARAM (рис. 8.5).  

8.4.2 Запустить симуляцию. График АЧХ до оптимизации (рис. 8.6) 
сохранить в заготовке отчета. 

8.4.3 Вызвать из меню Tools программы PSpice Schematics программу 
PSpice Optimizer (команда Run Optimizer). 

По команде Specifikations меню Edit  открыть окна рис. 8.3 и задать 
целевую функцию. Критерий оптимизации – равенство характеристик 
фильтра заданным значениям с некоторым допуском. 
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8.4.4 Положение движка соответствующего потенциометра связать с 
варьируемым параметром (рис. 8.5, б). Запустить процесс оптимизации 
(команда Tune>Auto>Start). 

 
Рисунок 8.5 – Определение оптимизируемого параметра 

 
Рисунок 8.6 – АЧХ полосового фильтра до оптимизации 
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 б) 

Рисунок 8.5 – Связь оптимизируемого параметра с положением движка 
потенциометра  

На каждой итерации процесса оптимизации в главном окне программы приводятся 
значения целевых функций, текущих значений-параметров, количество просмотренных 
вариантов (в графе Simulations) и суммарная ошибка (в графе RMS Error). Чем ближе 
фактические значения целевых функций к заданным значениям, тем меньше эта ошибка.  

Ошибка RMS учитывает только отклонения целевых функций от заданных 
значений, в нее не входят ошибки соблюдения ограничений. 

График АЧХ после оптимизации сохранить в заготовке отчета. 
8.4.5 Повторить п. 8.4.4 для двух других потенциометров. 
8.4.6 Сформировать (команда File>Report) и проанализировать 

текстовый отчет (расширение имени *.ООТ). 

8.5 Контрольные вопросы 
8.5.1 Что называется параметрической оптимизацией?  
8.5.2 Какие критерии оптимизации использовались в работе?  
8.5.3 В каких режимах анализа в PSpice можно рассчитать целевые 

функции для параметрической оптимизации?  
8.5.4 Как называется модуль программы OrCAD в котором выполняется 

параметрическая оптимизация?  
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Приложение А 

Команды программы PSpice Optimizer 
  

Меню File (Файл) 

New  Очистка рабочего окна для создания нового 
файла задания на оптимизацию (*. ОРТ)  

Open...  Открытие (загрузка) существующего файла 
задания на оптимизацию  

Save  Сохранение внесенных изменений в текущем 
файле  

Save As...  Сохранение внесенных изменений в новом файле, 
имя которого указывается по дополнительному 
запросу  

Report  Создание текстового файла отчета об 
оптимизации (*.ООТ)  

Exit (Alt+F4)  Завершение работы  

1, 2, ...  Список последних четырех загруженных файлов  

Меню Edit (Редактирование) 

Parameters...  Редактирование списка целевых функций и 
ограничений  

Specifications...  Редактирование спецификаций целевых функций 
и ограничений  

Store Values  Копирование текущих значений в качестве 
начальных значений спецификаций и 
параметров  

Reset Values  Копирование начальных значений в качестве 
текущих значений  

Round Nearest  Замена значения каждого параметра, 
соответствующего номиналу компонента, 
ближайшим стандартным значением 
(погрешность округления задается параметром 
Tolerance)  

Round 
Calculated  

Замена значения каждого параметра ближайшим 
стандартным значением, если новые значения 
целевых функций находятся в заданных 
пределах (расчет проводится на основе 
производных без повторения моделирования)  
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Update 
Schematic  

 
Перенос на схему оптимальных значений 
параметров  

 Меню Тune (Настройка)  

 Update 
Performance 

 
Расчет характеристик схемы для начальных и 
текущих значений каждого параметра  

 

 Update 
Derivatives  

 
Вычисление чувствительности каждой целевой 
функции к изменению каждого параметра  

 

 Show 
Derivatives  

 
Отображение матрицы чувствительностей  

 

 Auto  Управление процессом оптимизации в 
автоматическом режиме:  

 

 Start  Начало оптимизации   

 Terminate  Прекращение оптимизации   

 Меню Options (Параметры)  

 Defaults  Установка параметров оптимизации:   

 Delta  Относительное приращение 
параметров для расчета 
производных, в процентах  

 

 Max. Iterations  Максимальное количество 
итераций в процессе 
оптимизации  

 

 Probe File  Задание имени файла целевых 
функций .prb для программы 
Probe  

 

 Display  Имя конфигурации дисплея 
программы Probe, 
предварительно сохраненной 
по команде Tools>Display 
Configuration  

 

 Advanced 
Options  

Дополнительные параметры: 
Cutback – минимальная доля 
внутреннего шага изменения 
параметров; Thres hold – 
минимальный шаг изменения 
параметров; One Goal – выбор 
метода минимизации при 
задании значения функции в 
одной точке  
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 Recalculate  Режим расчета новых значений параметров и 
функций:  

 

 Auto  Автоматическое обновление 
результатов  

 

 Manual  Расчет параметров после нажатия 
кнопки Parameters, целевых функций 
– кнопки Results 
  

 

 Меню Help (Помощь)  

 About 
Optimizer...  

 
Вывод номера версии программы и ее 
регистрационного номера  

 

 Web 
Resources  

 
Выход в Интернет:  

 

 PSpice Home 
Page  

Загрузка сайта www.orcad.com   

 Customer 
Support  

Выход на службу технической 
поддержки www.orcad.com/technical  
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Приложение Б 

Целевые функции программы Probe 
 

Целевые функции общего назначения 

MAX (Track) – Находит максимальное значение графика Track 
MAXR (Track, begin_x, end_x) – Находят максимальное значение 

графика в пределах указанного диапазона X 
MIN (Track) – Находит минимальное значение графика Track 
MINR (Track, begin_x, end_x) – Находят минимальное значение графика 

в пределах указанного диапазона X 
XatNthY (Track, Y, n) – Находит значение X, соответствующему n-ому 

возникновению на графике Track значения Y 
XatNthYn (Track, Y, n) – Находит значение X, соответствующему n-ому 

возникновению на графике Track значения Y с отрицательным наклоном 
XatNthYp (Track, Y, n) – Находит значение X, соответствующему n-ому 

возникновению на графике Track значения Y с положительным наклоном 
XatNthYpct (Track, Y_pct, n) – Находит значение X, соответствующему n-

ому возникновению на графике Track значения Y_pct (в %) от полного 
размаха графика, то есть n-ое возникновение Y = Ymin + (Ymax-Ymin) 
*Y_pct/100 

YatX (Track, X) – Находят значение Y для графика Track в точке X 
YatXpct (Track, X_pct) – Находят значение Y для графика Track в точке, 

определяемой X_pct (в %) от всего диапазона Х 

Целевые функции для частотного анализа 

Bandwidth (Track, db_level) – Определяет полосу пропускания для 
графика Track для заданного уровня db_level (в дБ) 

LPBW (Track, db_level) – Находят значение X, в которой график Track 
впервые пересекает уровень (Ymax-db_level) с отрицательным наклоном 
(верхнюю граничную частоту НЧ фильтра) 

BPBW (Track, db_level) – Находит разность между значениями X, где 
график Track впервые пересекает уровень (Ymax-db_level) с положительным 
наклоном и затем с отрицательным наклоном (полоса пропускания). 

HPBW (Track, db_level) – Находят значение X, в которой график Track 
впервые пересекает уровень (Ymax-db_level) с положительным наклоном 
(нижняя граничная частота ВЧ фильтра) 

CenterFreq (Track, db_level) – Находит среднюю точку между значениями 
X, где график Track впервые пересекает уровень (Ymax-db_level) с 
положительным наклоном и затем с отрицательным наклоном, то есть 
центральную частоту 
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GainMargin (Track1, Track2) – Определяет для графика Track2 (АЧХ) 
значение (в дБ) в той же точке, где фаза графика Track1 (ФЧХ) отстала на 
180° 

PhaseMargin (Track1, Track2) – Определяет для графика Track2 (ФЧХ) 
фазу в той же точке, где график Track1 (АЧХ) пересекает уровень 0 дБ 

Целевые функции для переходного анализа 

Risetime (Track) – Находит разность между значениями X, где график 
сначала пересекает 10 % и затем 90 % максимального значения с 
положительным наклоном (фронт импульса) 

GenRise (Track) – Находит первые и заключительные значения Y графика 
на уровне 10 % и 90 % диапазона между стартом и установившимся 
значением с положительным наклоном (время установления включения) 

Falltime (Track) – Находит разность между значениями X, где график 
сначала пересекает 90 % и затем 10 % максимального значения с 
отрицательным наклоном (спад импульса) 

GenFall (Track) – Находит первые и заключительные значения Y графика 
на уровне 10 % и 90 % диапазона между стартом и установившимся 
значением с отрицательным наклоном, то есть время установления спада 
характеристики 

Overshoot(Track) – Находит разность между максимумом и конечными 
(заключительным) значениями Y графика, то есть выброс переходной 
характеристики 

Peak(Track, n) – Находит значение графика Track в n-ом пике (пик 
признан, если 3 точки данных до и после меньше значения Y) 

Period(Track) – Находит разность между первыми и вторыми значениями 
X, в которых график Track пересекает среднюю точку диапазона Y с 
положительным наклоном 

Pulsewidth(Track) – Находит разность между значениями X, где график 
пересекает среднюю точку диапазона Y с положительным наклоном, а затем с 
отрицательным наклоном, то есть находит ширину первого импульса 

SWINGr (Track, begin_x, end_x) – Находит разность между 
максимальными и минимальными значениями графика в пределах указанного 
диапазона, то есть размах сигнала 

TPmW2(Track, Period)= (y1-y2)*1000 / (x1-x2) – Находит разность между 
конечным (заключительным) значением Y графика Track и Y за один период 
перед этим, усредняет за период и умножает на 1000, то есть находит 
мощность рассеивания (в мВт) в течение конечного (заключительного) 
'периода' времени (Period). Можно использовать, если Track – мощность на 
нагрузке – интеграл V(нагрузка)* I(нагрузка)) 
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